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PREFACEPREFACE

The computer has become an integral part of our society. It has influenced almost 
every aspect of our lives; be it work or leisure. It is only through computers that we 
are able to organise and execute even the simplest of tasks. 

Snapshot is a series of five books for classes 1 to 5, which brings together ‘knowledge’ 
as well as ‘knowledge application’. Each book is based on Windows 10 and MS 
Office 2016. The books are integrated with National Curriculum Framework (NCF) 
2022.

In classes 1 and 2, students will gain basic knowledge of computer and its devices. 
They will also get to implement their creativity in Tux Paint and MS Paint. 

In classes 3, 4 and 5, students will enhance their skills by gaining knowledge about 
MS Word, MS Excel, MS PowerPoint, LOGO, Scratch, E-mail, Internet, Artificial 
Intelligence and Logical Reasoning.

Through this book, we want to promote modern ways of teaching in which the 
student gets to comprehend and implement knowledge as well as technical 
skills. Rather than restricting the inflow of knowledge to verbal teaching, we have 
included all kinds of activities to further add to the independence of students so 
that they can learn better.

Each chapter is introduced in a systematic manner. The illustrations, application 
screenshots, activities and exercises are curated in simple language to assist the 
teaching-learning process.

—Author
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PLAY-BASED LEARNING Inclusion of word puzzles such as word search, 
crosswords, word jumbles

ETHICS and VALUES Ethics and values like empathy, respect for others, 
equality, and justice

SOCIAL and EMOTIONAL 
LEARNING (SEL)

Self-awareness, Self-management, Decision-making, 
Social awareness, Relationship skills

COMMUNICATION Exchange of information, thoughts, and ideas

EXPERIENTIAL 
LEARNING Hands-on approach, learning through experience

CREATIVITY Imagination, organization, problem-solving,  
innovation

TECHNOLOGY and 
EDUCATION

Extensive use of technology in teaching and  
learning

CRITICAL THINKING Application of logic and reasoning in  
decision-making

Integrated with NCF 2022

DIGITAL AID

EL

PL

EV

SEL

CM

CR

TE

CT

Student’s Assist Teacher’s Assist

Audio and Video eBook
◊	 Features of a computer

	Student Worksheets

Test Paper Generator
◊	 Random and Manual Question Paper
◊	 Download papers in Word format

	 Lesson Plans

	Worksheets

	 Answer Key
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Salient Features

Chapter

7Chapter	1	I	Computer—A	Wonderful	Machine

1

LEARNING OBJECTIVES

In this chapter, students will learn about:
Natural	and	man-made	things
What	are	machines?
Computer—A	wonderful	machine
Why	is	computer	a	unique	machine?

SIGN IN

Colour the pictures.

Look at the two pictures you have coloured. Are they same?  
If not, then how are they different?

Yes,	they	are	different.	A	house	is	made	by	man	and	a	tree	is	a	natural	
thing.	In	this	chapter,	let	us	learn	about	natural	and	man-made	things.

 Computer—A Wonderful Machine

Scan QR Code to
watch a video
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Learning Objectives  
(Lesson Outline)

Activity Time  
(Creative Learning)

News Feed  
(Additional Information)

Sign In  
(Link to the Concept)

Refresh  
(Summary of the Lesson)

Let’s Explore  
(Practical Implementation)

37Chapter 4 I The Keyboard

Make the buttons of a keyboard

How to make—
• Take a chart paper. 
• Cut it into square pieces. (Ask your teacher or an adult for help.)
• Write one letter (A to Z) or number (1 to 10) on each piece. 

These are the buttons of your keyboard.
• Now, take another chart paper and paste the letters of your 

name and number of your birth date.

Name: 

Birth date (Birthday):

ACTIVITY TIME

• A keyboard is used to type on a computer.
• There are many keys on a keyboard.
• Alphabet keys are used to type letters.
• Number keys are used to type numbers.
• Some of the special keys are Arrow keys, Enter key, Spacebar 

key, Backspace key and Caps Lock key.

REFRESH

• Spacebar is the only key with nothing written on it on the keyboard.

NEWS FEED
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15Chapter	1	I	Computer—A	Wonderful	Machine

	 4. 	 It	is	used	to	talk	with	other	people.

     

	 5. 	 It	is	a	machine	with	colourful	beads.

     

a. b. c.

a. b. c.

•	 Roam	around	in	various	places	at	your	school.	Find	out	different	
types	of	machines	in	your	school.

LET'S EXPLORE

•	 Show	the	students	different	types	of	machines	such	as	mobile,	
refrigerator,	water	cooler,	air	conditioner,	vehicles,	etc.	which	can	
be	found	in	school.

•	 Also,	take	the	students	to	the	computer	lab	and	show	them	a	
computer	and	its	various	parts.	Explain	some	of	the	things	that	we	
can	do	using	a	computer.

FOR THE TEACHER
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91Periodic Assessment–4

PERIODIC ASSESSMENT 4
A. Identify the shapes and write their names.

	  	   		 	 	 		 	  

  1.    2. 

	 	          

  3.    4. 

B. With the help of the clues complete the words in the puzzle.

 Across →
2. It is a repeating arrangement.
4. It is the ability to learn.
5. Toy AI

Down ↓
1. It is a puzzle.
3. Voice AI

1 W

2 P

3 A
4 I E

5 A
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93Chapter 9 I Introduction to Artificial Intelligence

A. Draw the following in Tux Paint.

PROJECTPROJECT

B. Draw the following in MS Paint.
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92 Test Paper–2

TEST PAPER 2TEST PAPER 2

A. Tick (ü) the correct option.

  1. It is a natural thing.

   a.   b.    c. 

  2. It is a tool of Paint.

   a.   b.   c. 

B.  Write True (T) for the correct statements and False (F) for  
the incorrect statements.

 1. Tux Paint has a variety of drawing tools.  

 2. Brushes tool is used to draw freehand in Paint.  

 3. A triangle has two sides.  

 4. A tree is a natural thing.  

 5.  Artificial Intelligence refers to the ability  
of the machine to think and learn. 

C. Answer the following questions.

 1. Name two programs that you can use to draw on a computer.

 2. Which tool is used to draw a circle in Paint?

 3. How can we make a pattern?

 4. Write the names of four tools used in Tux Paint.

 5. Define man-made things? Give two examples.
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94 Chapter 9 I Introduction to Artificial Intelligence

(Sample Paper)

LOGICAL REASONINGLOGICAL REASONING

1. Tick the correct option to complete the pattern.

 
18

 
15

 
12

 
9

 
?

  a. 10   b. 8     c. 7    d. 6 

2. Select the odd one out.

  a. 8–4  b. 9–5   c. 7–6   d. 6–2

3. Which of the following is the smallest?

  a.         b.  

  c.    d.  

NATIONAL CYBER OLYMPIADNATIONAL CYBERNATIONAL CYBER  OLYMPIADOLYMPIAD
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Periodic Assessments  
(Revision of Lessons) Test Papers 

(Evaluation of 
Knowledge)

Project  
(Application of 

Knowledge)

National Cyber 
Olympiad  

(Preparation for  
Cyber Competition)
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Chapter

7Chapter 1 I Computer History and Development

Computer History and 
Development1

LEARNING OBJECTIVES

In this chapter, students will learn about:

Early counting devices

Generations of computer

SIGN IN

Solve the word problems given below.

1. 	 �The library near Reema’s house has 1,260 books in English; 1,120 books in Hindi; 
750 books in Tamil; 300 books in Korean and 560 books in French. How many 
books does the library near Reema’s house have? 

	

2. 	 �Sana has ₹ 5000. She spends ₹ 1,200 on Monday on books. She spends another 
₹ 2,100 on school supplies on Wednesday. How much is she left with on Thursday?

	

3. 	 �The cost of 20 books is ₹ 4,000. What will be the cost of one book? 

	

4. 	 �The cost of one bag is 825. What will be the cost of 15 bags? 

	

Counting has been a part of human life since the early years. Even before the computer 
was developed, people have invented tools for calculations to count and perform simple 
calculations. 

Scan QR Code to
watch a video

CT
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8 Chapter 1 I Computer History and Development

EARLY COUNTING DEVICES
In ancient times, people used stones, pebbles, sticks, fingers, toes, etc. for counting. 

Abacus
It is the first calculating device. The invention of the Abacus in China 
around 3000 years ago can be considered the first step toward 
computing. It is made up of a wooden frame with beads on rods. 
It is used for performing simple calculations such as addition and 
subtraction. It is also used to calculate numbers at a fast speed.

Nowadays, abacus is used for teaching number system in school. 	
It is also used as an aid in teaching calculation to virtually challenged 	
students. 

Napier’s Bones
It was invented by John Napier, a Scottish mathematician and 
scientist. It was a manual calculating machine in which numbers 
were carved on bones or on strips of wood. It was used for 
performing calculations such as addition, subtraction, division 	
and multiplication.

Pascaline 
Pascaline is the first mechanical calculator in the world. It was invented by Blaise Pascal, a 
French mathematician in 1642. It consisted of a rectangular box with movable wheels. The 
numbers were fed by dialing the wheels. It was used for addition and subtraction only. It is 
also called Arithmetic Machine.

Abacus

Pascaline Blaise Pascal

Napier’s Bones

	 Fingers	 Pebbles	 Sticks
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9Chapter 1 I Computer History and Development

Step Reckoner
Step Reckoner is a digital mechanical calculator invented by mathematician, Gottfried 
Wilhelm Leibniz in 1972. It could perform all four arithmetic operations—addition, 
subtraction, multiplication and division.

Step Reckoner

Analytical Engine
In 1822, Charles Babbage, a British mathematician invented a stream-driven calculating 
machine. He called the machine ‘The Different Engine’ and it was the size of a room. 
But this machine never became a reality even after working for 10 years. 

He also invented the first ever working model of the mechanical computer called the 
Analytical Engine in 1833. It has the same basic elements as in today’s computer—input, 
output, control, etc. 

Charles Babbage is considered the father of computers.

Analytical EngineCharles Babbage

Lady Ada Lovelace’s Programs
Lady Ada Lovelace is known as the first computer programmer. 
She is known for her work on Babbage’s Analytical Engine. She 
introduced the concept of storing data in the form of 0’s and 1’s. 

Herman Hollerith’s Tabulating Machine
A tabulating machine is a machine that can read and store 
data from punched cards. It was built by Herman Hollerith, an 
army engineer in 1890. He formed a company called Computing 
Tabulating Recording Company to sell his machines. Hollerith’s Lady Ada Lovelace
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10 Chapter 1 I Computer History and Development

company became a part of International Business Machines Corporation in 1924. Today 
this corporation is popularly known as IBM. 

Herman Hollerith        Hollerith’s Tabulating Machine

GENERATIONS OF COMPUTER
The computer has come a long way to reach this stage. Over the years, the initial computer 
has developed, improving in terms of size, accuracy, speed and price. This development of 
computers is divided into five subsequent phases called computer generations. Let us learn 
about these generations of computers.

First Generation Computers (1940s)
The first generation of computers started in the early 1940s. These 
computers use thousands of vacuum tubes which were often huge and 
it takes up a large amount of space. 

Some common features of first-generation computers are:

•	 They were a large size.
•	 They were very expensive to build.
•	 A large amount of power was required for these computers. 
•	 They were very slow.
•	 They could solve just one problem at a time. 

These are some of the computers that were a part of first generation 
computers.

Vacuum Tubes

A banknote counter or bill counter is a device designed primarily 
to accurately count the number of banknotes.

NEWS FEED
CM
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11Chapter 1 I Computer History and Development

MARK-I
It was the First Electro-Mechanical Powered 
Computer. It was built by Prof. Howard 
Aikens in 1943. It used punched cards and a 
typewriter for input and output. 

Mark-I

ENIAC

UNIVAC

ENIAC
ENIAC stands for Electronic Numerical Integrator 
And Computer. It was the first electronic 
computer. It was built by John Mauchly and 
Presper Eckert in 1946. It was 1000 times faster 
than Mark-I. It has over 18,000 vacuum tubes.

UNIVAC
John Mauchly and Presper Eckert invented UNIVAC 
(Universal Automatic Computer) in 1951. It could handle 
both numeric and textual information. It had 5200 
vacuum tubes. 

Second Generation Computers (1950s)
Second generation computers were introduced in the 
late 1950s. They used transistors instead of vacuum 
tubes. Major computer manufacturers started offering a range of 
accessories such as page printers, cathode-ray-tube displays and 
card feeders, etc. during this phase.

IBM 600 and IBM 1401 are some examples of second generation 
computers.

Some common features of second generation computers are:

•	 They were smaller and less expensive than the first generation computers.
•	 They were faster and more reliable than the first generation computers.
•	 They used magnetic tapes to store data.

Third Generation Computers (1960s)
The third generation computers used Integrated Circuits or ICs. It is also known as chip. 

Some common features of third generation computers are:

•	 They used Integrated Circuits (ICs).
•	 They had more storage capacity than the second generation computers.

Transistor
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12 Chapter 1 I Computer History and Development

•	 They were smaller in size and the speed increased because 	
of the use of ICs.

•	 They consumed less power. 
•	 They were more affordable and dependable. 

Fourth Generation Computers (1970s)
The fourth generation computers use microprocessors which is 
a type of Very Large Scale Integration (VLSI). A microprocessor 
contains a large number of ICs.

Some major developments of this time are:

•	 IBM released their first line of desktop PC.
•	 Microsoft released the first version of Microsoft Windows. 
Some common features of fourth generation computers are:

•	 Use of the microprocessor made the computers small which can be placed on a table. 
•	 They use hard disks to store data.
•	 They are very powerful and reliable.
•	 Introduction of GUI operating system made the computers easy to use.

Fifth Generation Computers (Present)
Fifth generation computers use powerful microprocessors which are developed using VLSI 
technology. Intel introduced the MMX microprocessors in 1997. It was designed to improve 
gaming and multimedia performance. Another major development is the introduction of 
Artificial Intelligence (AI), i.e. developing computers with thinking power. 

Integrated Circuits

Microprocessor

The first personal computer, the Altair 8800, was created by MITS in 1974.

NEWS FEED

Some common features of fourth generation computers are:

•	 Advanced versions of GUI operating systems are developed.
•	 Introduction of Artificial Intelligence (AI) which makes a computer do some of the things 

like humans do such as reorganizing voice, identifying human faces, making decisions, 
being able to understand different languages, etc.

CM
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13Chapter 1 I Computer History and Development

ACTIVITY TIME

Match the machines with their inventors.

1. 	 	 a. 	

2. 	 	 b. 	

3. 	 	 	
c.

4. 	 	 d. 	

5. 	 	 e. 	

CMCT
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14 Chapter 1 I Computer History and Development

•	 In ancient times, people used stones, pebbles, sticks, fingers, toes, etc. for counting. 
•	 Abacus is the first calculating device and it was invented in China.
•	 Pascaline is the first mechanical calculator in the world.
•	 Charles Babbage invented the first ever working model of the mechanical computer 

called the Analytical Engine.
•	 Lady Ada Lovelace is known as the first computer programmer.
•	 The development of computers is divided into five subsequent phases called 

computer generations.
•	 The first generation of computers used thousands of vacuum tubes.
•	 The second generation of computers used transistors.
•	 The third generation of computers used Integrated Circuits.
•	 The fourth generation of computers uses microprocessors.
•	 The fifth generation of computers uses powerful microprocessors which are 

developed by VLSI technology. 

REFRESH

BROWSE

A 	 Choose the correct option. 

	 1. 	 �  is the first computing device .

	 	 a.   Napier’s Bones	 	 b.   Abacus	 	 c. 	 Pascaline�

	 2. 	 The device invented by Gottfried Wilhelm Leibniz in 1972 is .

	 	 a.   Step Reckoner	 	 b.   Analytical Engine	 	 c.  � Tabulating� 	
Machine

	 3. 	 There are  generations of computers.

	 	 a.   6	 	 b.   4	 	 c.   5�

	 4. 	 Who build Mark-I?

	 	 a.   John Mauchly	 	 b.   Prof. Howard Aiken	 	 c.   Presper Eckert�

	 5. 	 This is a second generation computer.

	 	 a.   IBM 1401	 	 b.   ENIAC	 	 c.   UNIVAC�
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15Chapter 1 I Computer History and Development

B 	 Fill in the blanks using the words given below.

Step Reckoner    Napier’s Bones    transistors
Charles Babbage    Vacuum Tubes

	 1. 	  was invented by John Napier.

	 2. 	  could perform all arithmetic inventions. 

	 3. 	  is considered the father of computers. 

	 4. 	 First generation of computers used thousands of . 

	 5. 	 Second generation of computers used  .

C 	 Write T for true statements and F for false statements.

	 1. 	 �Abacus was invented 2500 years ago. 	 �

	 2. 	 Pascaline invented the Arithmetic Machine. �

	 3. 	 Gottfried Wilhelm Leibniz invented the Tabulating Machine.�

	 4. 	 ENIAC stands for Electronic Numerical Integrator And Computer.�

	 5. 	 Fifth generation of computers introduced AI.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	 Give two examples of early counting devices.

	 	

	 2. 	 What is the other name of Pascaline?

	 	

	 3. 	 What did Lady Ada Lovelace introduce?
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16 Chapter 1 I Computer History and Development

	 4. 	 What is MARK-I?

	 	

	 5. 	 What does ENIAC stand for?

	 	

E 	 Answer the following questions.

	 1. 	 �How was calculation done in ancient times?

	 2. 	 Write a short note on Herman Hollerith’s Tabulating Machine.

	 3. 	 �Write four differences between first generation computers and second 
generation computers.

	 4. 	 Write the common features of third generation computers.

	 5. 	 �How were the fourth generation computers different from the fifth generation 
computers? Write any three differences.

ACTIVITY TIME

Identify the pictures given below and write the correct names. Choose from the  
help box.

Mark-I    Charles Babbage    Napier’s Bones    Vacuum tubes    UNIVAC    Pascaline

1. 	 2. 	 	 3. 	

CT
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17Chapter 1 I Computer History and Development

4. 	 5. 	 	 6. 	

•	 Using the Internet, search for information and pictures of fourth and fifth generation 
of computers.

•	 On a chart paper, paste the pictures and write the information.

LET'S EXPLORE

•	 Show Abacus and demonstrate its uses to the students. 
•	 Explain the different calculating machines that were invented.
•	 Elaborate how the computer evolved through different generations. 
•	 Discuss the unique features of each generations of computer. 

FOR THE TEACHER

EL TE
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Advanced Features of Word 20162

LEARNING OBJECTIVES

In this chapter, students will learn about:

Thesaurus

Find and Replace text

Formatting a page 

Formatting a paragraph

Mail Merge 

SIGN IN

Label the picture using the words given below.

We have learnt in the previous class some of the features that help us to edit a document 
in Word. In this chapter, we will learn about more advanced features of Word that can be 
used to make changes in a file. 

Align Left    Center    Right Align    Decrease Indent    Increase Indent

Scan QR Code to
watch a video

CT
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19Chapter 2 I Advanced Features of Word 2016

THESAURUS
Thesaurus is a collection of words that have similar meanings, i.e., synonyms. In Word, 
using the Thesaurus tool we can search for a list of synonyms for a selected word. 

Follow these steps to use the Thesaurus tool:

1.	 Select the word.
2.	 Click on the Review tab. 
3.	 Click on the Thesaurus tool in the Proofing group.
	 The Thesaurus pane will open up on the left side of the window. A list of synonyms for 

the selected word will open on this pane. 
4.	 To select the synonym, click on the down arrow and select Insert or copy. 

2

1

3
4

The shortcut to Thesaurus: Shift + F7

QUICK BYTE

The lines of the song ‘Scrollin’ by the Funny Music Project refer to features of Microsoft 
Word, with lines such as "Paste in now cut out/Page up now page down".

NEWS FEED

FIND AND REPLACE TEXT
In Word, we can find a specific word or phrase in a document and replace it with another 
word or phrase. 

CM

CM
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20 Chapter 2 I Advanced Features of Word 2016

Find
If we want to search for a word or phrase in a document, we can find it by using the 
command Find. The Find feature in Word helps us to find a word or phrase in the 
document.

Follow these steps to find a word or a phrase:

1.	 Click on the Home tab. 
2.	 Click on the Find tool in the Editing group. 
	 A Navigation pane will appear on the left side of the window. 
3.	 In the textbox, type the word or phrase that you want to search. 
	 All the occurrences of the word or the phrase in the document will be highlighted.
	 Under Results in the Navigation pane, you can also see a preview of all the sentences 

or sections which contain the word or the phrase in the document. 
4.	 Click on the Results to see the result. 

3

4

2
1

Replace Text
Word also allows to replace a word with other words. This is called the Replace feature of 
Word. 

Follow these steps to find a word or a phrase with another word or phrase:

1.	 Click on the Home tab.
2.	 Click on the Replace tool in the Editing group. A Find and Replace dialog box will 

appear. 
3.	 In the Find what box, type the word or phrase to be replaced.
4.	 In the Replace with box, type the word or phrase to replace the search word.
5.	 Click on Find Next button. Word will search for it and will be highlighted if the word is 

there. 
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6.	 Click on Replace button or Replace All button to replace the word. 

4

56

3

1

2

FORMATTING A PAGE
The way we set the elements on a page can be changed and arranged according to the 
way we like. Page formatting means arranging the elements of a page in a layout that we 
want. Many page formatting tools are available in the Layout tab in Word 2016. 

Page Orientation
A paper can be placed in two ways, horizontally i.e., along its length and vertically i.e., 
along its width. Similarly, text or images can be set in these two ways on a page. Page 
orientation is the direction in which the text or the images appears on a page. There are 
two types of page orientations in Word—Landscape and Portrait. 

•	 In Portrait orientation shorter edge is on the top. It is taller than it is wide.
•	 In Landscape orientation longer edge is on the top. It is wider than it is tall. 

	 Portrait	 Landscape
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In Word, portrait is the default orientation. We can change the orientation of a file.

Follow these steps to change or define the orientation of a file:

1.	 Click on the Layout tab.
2.	 Click on the Orientation command in the Page Setup group.
3.	 Click on Portrait or Landscape as required from the drop-down menu.

1

2

3

Page Size
Paper size means the actual length and width of the paper. There are different sizes of 
paper for different types of documents. We can choose the page size according to the 
requirement. Letter is the default paper size in Word. 

Follow these steps to change the page size:

1.	 Click on the Layout tab.
2.	 Click on the Size command in the Page 

Setup group. 
3.	 Choose the paper size you want for your 

document. 
	 A4 is the standard Paper size.  

Page Breaks
Page breaks command is used to end a page 
at a certain point. We can insert a Page Break 
using the Page Breaks command.

Follow these steps to insert a page break in a 
document:

1.	 Click where the Page Break is to be 
inserted.

1

2

3
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2.	 Click on the Layout tab.
3.	 Click on the Page Breaks command in the Page Setup group.
4.	 Choose the page size you want to use. A page break will be inserted in the file. 

4

2

3

1

FORMATTING A PARAGRAPH
We can change the appearance of a paragraph. Paragraph formatting is a change 
in the appearance of the paragraph such as alignments, line and paragraph spacing, 
highlighting, adding borders, etc.

Let us learn how to format line and paragraph spacing.

Line Spacing
Line spacing refers to the amount of vertical space between each line of text in a 
paragraph. Word offers multiple options to change the spacing such as 1, 1.15, 1.0, 2.0, etc. 

Method 1
Follow these steps to change the line spacing in a paragraph: 

1.	 Place the cursor where you want to change the line spacing in the paragraph without 
selecting it.

2.	 Click on the Home tab.
3.	 Click on Line and Paragraph Spacing tool  in the Paragraph group.
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4.	 Place the mouse pointer on the various line spacing options. You can see the preview 
of the line spacing. Choose the line spacing you want. 

3

4
1

2

Method 2
Click on the Paragraph pull-down arrow of the Paragraph group under the Home tab. A 
Paragraph dialog box will open. Choose a style of line and click on the OK button. 

Click here

Paragraph Spacing
Paragraph spacing refers to the amount of vertical space between paragraphs. 

Follow these steps to change the paragraph spacing:

1.	 Select the paragraphs for which you want to change the spacing.
2.	 Click on the Layout tab. 
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3.	 In the Spacing section of Paragraph group, either enter the value or use arrow keys 
for Before  and After  to change the space at the 
beginning and at the end of a paragraph. 

3

1

2

MAIL MERGE
Mail merge in MS Word is a feature that helps us to create and send multiple letters and 
invitations to many people. Using this feature, we can send the same text to different 
addresses. It is a very helpful feature as we do not need to create the letter or invitation for 
each person separately. 

These are three main steps of the mail merge process: 

I.	 Creating a main document
	 The main document contains the basic text that is same in all the documents. It is the 

body of the letter or invitation. It contains merge fields with instructions to insert text 
from a data source such as the addresses or the name of the recipient. 

II.	 Creating a data source
	 Personalized information of the recipients of the letter or the invitation is contained 

in a data source. The information can be names, addresses, e-mail addresses, phone 
numbers, etc. This information is inserted in the merge field of the main document.

III.	 Merging the documents
	 The main document and the data source will be combined.
	 Let us learn how to create these documents and merge them. 
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I.  Creating a main document
You are the President of the club ‘Green Earth’ and the club is organizing a one-day event 
on June 5 to observe World Environment Day. You have to send out the invitation to the 
students. 

Follow these steps to create the main document:

1.	 Open Word and type the invitation.
2.	 Click on the Mailings tab.
3.	 Click on the Start Mail Merge option in the Start Mail Merge group. A drop-down 

menu will appear. 
4.	 Select and click on Letters from the drop-down menu.

1

4

2

3
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II.  Creating a data source
After the main document is ready, we have to select the recipients. 

Follow these steps to select the recipients:

1.	 Click on the Mailings tab.
2.	 Click on the Select Recipients option in the Start Mail Merge group. A drop-down 

menu will appear.
3.	 Click on Type a New List from the drop-down menu. A New Address List box will 

appear. 

3

1

2

4.	 Type the details of the recipients in the New Address List box. 

a.	To add another, select New Entry. 

b.	To delete an entry, select Delete Entry.
5.	 Click on the OK button after entering the details. A Save Address List box will appear 

where the address can be saved.

5

4
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6.	 Type the name of the list to save in the File name box and click on the Save button. 

6

7.	 Then place the cursor where the addresses of the recipients are to be added and click 
on the Address Block options from the Write and Insert Fields group in the Mailings 
tab. A window with a preview of the address will appear. Click on the OK button.

7

	 <<Address Block>> will appear in your document. We can also edit the details of the 
recipients using the option Edit Recipient List from the Start Mail Merge group. 

8.	 To add a greeting line for the addressee, click on the Greeting Line command. A 
window with a preview of the greeting line will appear. Click on the OK button. 

	 <<GreetingLine>> will appear in your document.
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9.	 To see a preview of the letter, click on the Preview Results button from the Preview 
Results group.

	 Greeting Line 	 Fields merged into the invitation

8

9

Preview of the final invitation

III.  Merging the documents
We have to merge the main document and the data source after creating both documents.

Follow these steps to merge the two documents:

1.	 Click on the Mailings tab.
2.	 Click on Finish & Merge command in the Finish group. A drop-down menu will appear.
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3.	 Select and click on Print Documents from the drop-down menu to print the personalized 
copies of the letters.

1

2
3

The games "Ribbon Hero" and "Ribbon Hero 2," designed by Office Labs, are 
developed to help users learn the features of Word 2007 and 2010.

NEWS FEED

ACTIVITY TIME

Write the name of the groups where you can find these tools and commands.

1. 	 Find tool�

2. 	 Thesaurus tool�

3. 	 Orientation�

4. 	 Line and Paragraph Spacing tool�

5. 	 Page Breaks�

•	 Thesaurus is a collection of words that have similar meanings.
•	 The Find feature in Word helps us to find a word or phrase and replace it in the 

document.
•	 Page formatting means arranging the elements of a page in a layout that we want.
•	 Page orientation is the direction in which the text or the images appears on a page.
•	 In Word there are two types of page orientations—Landscape and Portrait.
•	 Paper size means the actual length and width of the paper.

REFRESH

CM

CM CT
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•	 Page break is used to end a page at a certain point.
•	 Paragraph spacing refers to the amount of vertical space between paragraphs.
•	 Mail merge in MS Word is a feature that helps us to create and send multiple letters  

and invitations to many people.

BROWSE

A 	 Choose the correct option.

	 1. 	� It is the arrangement of elements of a page in a layout that we want.

		  a.   Page Formatting	 	 b.   Page Orientation	 	 c.   Page Breaks�

	 2. 	 It is the length and width of the paper.

		  a.   Page Orientation	 	 b.   Page Breaks	 	 c.   Page Size�

	 3. 	 It is to change the appearance of a paragraph.

		  a.   Page Formatting	 	 b.  � Paragraph	 	 c.   Page Breaks�  
Formatting

	 4. 	� It is a feature of Word that helps us to create and send multiple letters and 
invitations.

		  a.   Start Mail Merge	 	 b.   Mailings	 	 c.   Mail Merge�

	 5. 	 It is the final step in the mail merge process.

		  a.   Creating a main document	 	 b.   Creating a data source�

		  c.   Merging the documents	

B 	 Fill in the blanks using the words given below.

	 two          formatting            Size            page            Thesaurus

	 1. 	�   is a collection of words that have similar meanings. 

	 2. 	 There are  types of page orientation in Word.

	 3. 	  command is found in the Page Setup group.
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	 4. 	� Line spacing and paragraph spacing are parts of paragraph 

. 

	 5. 	 Page breaks is a command to format a .

C 	 Write T for true statements and F for false statements.

	 1. 	 Word has a feature that allows you to find and replace words.�

	 2. 	� There is only one size of paper for different types of documents  
in Word.�

	 3. 	 The page orientation is fixed in Word.�

	 4. 	 Word has multiple options to change line spacing.�

	 5. 	� Paragraph spacing refers to the amount of horizontal space  
between paragraphs.�

D 	 Answer the following question in one word or one sentence.

	 1. 	 What is the default page orientation in Word?

		

	 2. 	 What do call a document that is taller than it is wide?

		

	 3. 	 What do you call a document that is wider than it is tall?

		

	 4. 	 What is the default paper size in Word?

		

	 5. 	 Which feature of Word is used to insert a page break?
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E 	 Answer the following questions.

	 1. 	� What is paragraph spacing? Write the steps to change the spacing between 
paragraphs.

	 2. 	� How would you define the orientation of a page? Write the steps.

	 3. 	 Differentiate between portrait orientation and landscape orientation. 

	 4. 	 What are the main steps of the mail merge process?

	 5. 	 Write the steps to create a data source.

ACTIVITY TIME

Fill in the boxes with the correct numbers.

1. Changing page orientation
2. Inserting page break

3. Creating data source in Mail merge
4. Changing line spacing

a. 		  b.

c. 		  d.

CT
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•	 Explain all the features of Word that can be used to edit a document.
•	 Demonstrate how to find and replace text, format page, and mail merge. 

FOR THE TEACHER

In the computer lab, perform this task.

•	 Open MS Word. 
•	 Set the page orientation in Portrait.
•	 Change the font style to Times New Roman, size 14 point.

•	 Type the following text.

•	 Center align the title.

LET'S EXPLORE

Sharing and Caring

Sharing is an act of kindness where we offer something of ours to someone else who 
might need it. We can also say sharing is a process of dividing and distributing. It also 
means joint use of resources or space. Sharing is developed over the years. Since 
childhood, we are taught to share our toys and play together with friends and siblings.

Sharing is an important social-skill. It strengthens social ties. It helps create trust, security 
and happiness. When we share it not only shows we care for others but also helps in 
self-development. We learn to be humble and caring. We share not only things but also 
feelings and knowledge too.

Caring means to do something good for someone. It also means to show kindness and 
concern for another person. Caring is also supporting someone when he/she goes through 
tough times. It is also helping someone in times of need.

•	 Change the line spacing on both paragraphs to 1.5 spacing.

•	 Right align the first paragraph.  

•	 Justify the second paragraph.

•	 Left align the third paragraph.

•	 Find the word caring and replace it with compassionate in the entire text.

•	 Find the meaning of the following words using the Thesaurus:
	 kindness		  resources		  humble		  tough

EL TE
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PERIODIC ASSESSMENT 1 

A.	 Identify the pictures and write their names.

	                               
	 1.	 	 2.  	 3. 

B.	 Name the inventor of these machines.

	 1.	 Pascaline: 

	 2.	 Leibnis Step Reckoner: 

	 3.	 Analytical Engine: 

C.	 Fill in the blanks.

	 1.	  is the first computer programmer.

	 2.	 ENIAC is the  generation computer.

	 3.	 In  orientation, shorter edge is on the top.

	 4.	  is the default size in Word.

	 5.	� Page  means arranging elements of a page in a 
layout that we want. 

D.	 Match the following.

	 1.	 Find tool	 a.	 Paragraph Group

	 2.	 Landscape 	 b.	 Editing Group 

	 3.	 Size command	 c.	 Start Mail Merge 

	 4.	 Line and paragraph	 d.	 Page Orientation

	 5.	 Select Recipients option	 e.	 Page Setup
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Formatting a Presentation—Adding 
Special Effects3

LEARNING OBJECTIVES

In this chapter, students will learn about:

Themes

Working with Slide Master

Changing the background

Inserting SmartArt

Slide transitions 

Animation effects

SIGN IN

Introduce yourself to the class. You can use pictures of you and your family to 
make it more interesting.

You might want to include:

•	 facts about you
•	 facts about your family
•	 your likes and dislikes
•	 your thoughts about the school
•	 your Personality
•	 your future plan

PowerPoint is a program used to create a presentation. Presentation is a commonly used 
tool to share information and ideas with a group of people. We can use words, pictures, 
audio, videos and other multimedia in a PowerPoint presentation. To make a presentation 
more effective we can format and add special effects. 

Scan QR Code to
watch a video

CM CR
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THEMES
We can make a presentation in a blank presentation or use a theme. A theme is a set of 
colours, fonts and visual effects that the slides in a presentation have in common. Themes 
offer an easy option to change the look or design of a presentation. The elements in a 
theme such as colours, fonts and effects are pre-set and different for each theme.

Applying theme
Follow these steps to apply a theme to your presentation:

1.	 Click on the Design tab. A list of available themes will appear. 
2.	 Click on the More drop-down arrow to see all the available themes.
	 Hover the mouse pointer over a theme to see a preview of the theme in the 

presentation.
3.	 Select and click on the theme you want to apply to your presentation. The theme will 

be applied to the presentation.

Selected theme of the presentation

3

21

MODIFYING THEMES
We can modify the elements of a theme after it is chosen using the variants group. 
Variants give the option to change colour, font, effect and background for the same theme. 

Variants group
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Change Theme Colours
Follow these steps to change the theme colours:

1.	 Click on the Design tab.
2.	 Click on the drop-down arrow in the Variants group.
3.	 Select colours from the options. 
	 A menu for various colour options will appear. Hover the mouse to see a preview of 

the colour.
4.	 Select the colour you want to apply.

1

2

Change Theme Fonts
Follow these steps to change the fonts:

1.	 Click on the Design tab.
2.	 Click on the drop-down arrow in the Variants group.
3.	 Select Fonts from the options. A menu for various font options will appear. 
4.	 Select the font you want to use.

Presentation in different theme colours

4 3

1

2

4
3
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Change Theme Fonts
Follow these steps to change the fonts:

1.	 Click on the Design tab.
2.	 Click on the drop-down arrow in the Variants group.
3.	 Select Fonts from the options. A menu for various font options will appear. 
4.	 Select the font you want to use.

Presentation in different theme colours

4 3

1

2

4
3

Similarly, we can change to new theme effects and background styles using the Effects 
and Backgrounds option in the Variants group. 

WORKING WITH SLIDE MASTER
In PowerPoint, the slide which is used to create the default layout and the appearance of 
the presentation is the Slide Master. When new slides are added to the presentation and 
slide layout is applied, the slides are automatically formatted according to the slide master. 

We can use slide master to make these changes in all the slides at the same time:

•	 Rearrange the placeholders 
•	 Modify and customize the background 
•	 Edit and format text such as font, font color, etc. 
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Follow these steps to create and modify slide masters:

1.	 Click on the View tab.
2.	 Click on Slide Master command in the Master Views group.

1

2

	 The Slide Master Task pane will appear on the left side of the 
PowerPoint. The first slide on the task pane is the Slide Master. 
It appears as the active tab on the ribbon. Make the required 
changes in the Slide Master. In this presentation, we will change 
the background style. Changes we make in the Slide Master will 
affect in each slide layout. 

3.	 To edit the background style, click Background Style in the 
Background group of the Slide Master tab. A drop-down menu 
will appear, showing the background options. Select the one you 
want to use. 
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	 The Slide Master will take on the selected background style and it will reflect on all the 
slides.

4.	 When all the changes are made, click on the Close Master View command to close the 
Slide Master.

PowerPoint was created in 1987 by a company called Forethought Inc. and was 
originally called ‘Presenter’.

NEWS FEED

CHANGING THE BACKGROUND
Follow these steps to change the background of the slides:

1.	 Click on Design tab.
2.	 Select Format Background command in Customize group. On the right side of the 

window, a Format Background task pane will open.

CM

Computer G5_Ch-3.indd   41Computer G5_Ch-3.indd   41 27-02-2023   11:19:2527-02-2023   11:19:25



42 Chapter 3 I Formatting a Presentation—Adding Special Effects

3.	 Choose and click on the radio button of the fill option you want. 

1

2

3

Format Background has four fill effects—

•	 Solid Fill: It is used to add one solid colour background to the slides. Click on the down 
arrow of Color option to choose any colour. 

•	 Gradient Fill: It is used to change the background of the slides with two or more colours. 
In gradient fill, there is a gradual change from one colour to another. Click on the down 
arrow of Preset Gradients to choose the gradient you want and to choose colour, click 
on the Color option.

A slide with the selected colour
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•	 Picture or Texture Fill: It is used to add a picture or a texture to the background of a 
slide. Click on the Insert button in Picture source section to add a picture. Click on the 
drop-down of the Texture option to add a texture. Here we have added a texture to the 
background.

•	 Pattern Fill: It is used to add a pattern of two colours to the background of a slide. 
Choose the pattern of your choice from the available patterns. The foreground and 
background colours can also be changed. 

INSERTING SMARTART
In PowerPoint, we can present information and ideas in graphic form using SmartArt. A 
SmartArt graphic is a visual representation of information and ideas through graphics 
that contain text. SmartArt graphics has eight categories—List, Process, Cycle, Hierarchy, 
Relationship, Matrix and Picture. 

Follow these steps to insert SmartArt to your slide:

1.	 Click on Insert tab.
2.	 Select SmartArt in Illustration group. A Choose a SmartArt Graphic dialog box will 

appear. 
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3.	 Choose a category and a graphic layout. When you click on the graphic layout option, 
a preview of the layout will appear. Here we have chosen List. 

4.	 Click OK button. 
5.	 To type the desired text, click on [Text] in each individual shape. 

4

5

1

3

2

The look of SmartArt can be changed by changing the fill of its shape or text, by adding 
effects such as shadows, reflections, glows or soft edges. 

ANIMATION EFFECTS
Animation is the element used in a presentation that makes objects move on a slide. It is a 
special visual effect. Animation effects are used to make a presentation more interesting 
and attractive. It enhances the appearance of the presentation. 

Follow these steps to add animation to your presentation:

1.	 Click on the image or the text to be animated.
2.	 Click on the Animation tab. 
3.	 Click on More button in the Animation group. A drop-down menu with various 

animation effects will open. 
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Types of Effects
The various animation effects are grouped into four categories.

•	 Entrance: Entrance effects control the way objects appear on your slide.

•	 Emphasis: Emphasis effects control how the audience’s eye is drawn to the animated 
object.

•	 Exit: Exit effects control how the animated objects will leave the slide.

•	 Motion Paths: Motion paths control the movement of your text or objects around the 
slide.

4.	 Choose the animation effect you want to apply. A number will appear before the 
selected text or object.

2
3

4
1
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Timing of animation effects
Follow these steps to add or modify the timing of the animation effects:

1.	 Click on the Animation tab.
2.	 Click on the drop-down menu of Start in the Timing group. Select the option you want 

to apply.
•	 On Click: The animation will begin on the click of the mouse. 
•	 With Previous: The animation begins at the same time as the previous animation in 

the list.
•	 After previous: The animation will begin immediately after the previous animation 

end.

3

41

2

The average number of words on a PowerPoint slide is 40 words.

NEWS FEED

3.	 In the Duration box, enter the number of seconds that you want the animation to run. 
4.	 Click on Move Earlier or Move Later to reorder the animation. 

Animation Pane
Follow these steps to open Animation Pane:

1.	 Click on Animation tab.
2.	 Click on Animation Pane in Advanced Animation Group.
	 A task pane will appear on the right side. This will show the number of text or object 

with the applied animation effects. 

CM
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3.	 Click on the down arrow of each applied animation effect, if you want to reorder them.

Removing an Animation Effect
To remove an animation, click on the number to be removed. The number box will get 
highlighted and then press the Delete key. 

Animation effects can also be removed from the Animation Pane. Click on the effect you 
want to remove and press the Delete key.

SLIDE TRANSITIONS
When we move from one slide to the next during a presentation, we can use a visual effect 
or animation to fill the gap between the slides. This visual effect or animation is known 
as slide transition. Transition is the way one slide follows during a presentation. We can 
control the speed, add sound and customize the look of transition effects.

Follow these steps to apply a transition in a presentation:

1.	 Select the slide you want to apply the transition from the Slide Navigation. 
2.	 Click on Transitions tab.
3.	 Click on More button in the Transition to This Slide group. 

A drop-down gallery of various transition effect options will open up. 

2
1 3

There are three categories of transition effects in PowerPoint.

•	 Subtle: This has simple and basic transitions.

2
3

1
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•	 Exciting: This category has more complex transitions than the basic category. 

•	 Dynamic Content: These transitions are applied only to the content, such as text and 
images. They do not apply to the background. 

4.	 Click on the transition you want to apply to the selected slide. A preview of the 
transition will appear in the slide area. 

Timing of slide transition
Follow these steps to add or modify the timing of a transition:

1.	 Click on Transition tab.
2.	 Click on Sound drop-down arrow in the Timing group. 
3.	 Select the sound you want to add to your transition. Enter the duration you want to run 

in the Duration box. 
4.	 Click on Apply to All option, if the transition is to be applied to all the slides.
5.	 Choose how you want to move to the next slide in the Advanced Slide option.  It has 

two options.
•	 On Mouse Click: The next slide will appear only when the mouse is clicked or a key 

is pressed on the keyboard.
•	 After: The next slide will appear after the given number of seconds.

2

1

4

5

3
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ACTIVITY TIME

Identify the animation effects and write the names of their group.

1. 	 	 	 2. 	 	

3. 	 	 	 4. 	 	

•	 Presentation is a commonly used tool to share information and ideas with a group of 
people.

•	 A theme is a set of colours, fonts and visual effects that the slides in a presentation 
have in common.

•	 The colour, font, effect and background for a theme can be used using the variants 
group.

•	 Slide Master is the slide that is used to create the default layout and the appearance 
of the presentation.

•	 The background of a presentation can be changed by using the Format background 
command. 

•	 Format Background has four fill effects.
•	 A SmartArt graphic is a visual representation of information and ideas through 

graphics that contain text.
•	 Animation is the element used in a presentation that makes objects  

move on a slide.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	� What indicates the animation order in the animation Pane?

		  a.   Letter	 	 b.   Number	 	 c.   Alphabet�

	 2. 	 What indicates that the Sound Clip has been added on the slide?

		  a.   Microphone icon	 	 b.   Speaker icon	 	 c.   Headphone icon�

CM CT

Computer G5_Ch-3.indd   49Computer G5_Ch-3.indd   49 27-02-2023   11:19:2727-02-2023   11:19:27



50 Chapter 3 I Formatting a Presentation—Adding Special Effects

	 3. 	 Which tab do you click to add a transition for a slide?

		  a.   Design	 	 b.   Transitions	 	 c.   Animations�

	 4. 	 Which tab is used to change the background colour of a slide?

		  a.   Transitions	 	 b.   Animations	 	 c.   Design�

	 5. 	 Which option allows you to select a texture for background?

		  a.  � Picture or	 	 b.   Pattern fill	 	 c.   Gradient fill�  
texture fill

B 	 Fill in the blanks with the words given below.

	 Entrance            four            Variants            Subtle            Motion

	 1. 	� The elements of a theme can be modified using the  
group.

	 2. 	 Format background has  fill effects. 

	 3. 	�   effects control how the object enters the slide.

	 4. 	  Paths make an object move within a slide.

	 5. 	 Morph effect is a  transition.

C 	 Write T for true statements and F for false statements.

	 1. 	 The colour of a theme can be changed through the Variants group.�

	 2. 	 Slide Master command is under the Animation tab.�

	 3. 	 Transitions help you add movement to elements on the slides. �

	 4. 	 Animations are visual effects between slides. �

	 5. 	 Slide transition is a type of effect used to make the slide disappear. �

D 	 Answer the following questions in one word or two words.

	 1. 	 Which effect is used to add one solid colour background to the slides?
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	 2. 	� Which effect is used to change the background of the slides with two or more 
colours?

		

	 3. 	� Which effect is used to add pictures and textures to the background  
of a slide?

		

	 4. 	� Which effect is used to add a pattern of two colours to the background  
of a slide?

		

E 	 Answer the following questions.

	 1. 	 Differentiate between animation and transition.

	 2. 	� What are the uses of transitions?

	 3. 	 How is a Slide Master useful in creating a presentation?

	 4. 	 Write the steps to change the colour scheme of a theme.

	 5. 	 How can you insert sound in a presentation?

ACTIVITY TIME

Match the effects with the correct names.

1. 	 	 a. 	 None

2. 	 	 b. 	 Morph

3. 	 	 c. 	 Fade

4. 	 	 d. 	 Push

5. 	 	 e. 	 Cover

CT
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In the computer lab, do this activity.

Create a presentation on ‘Endangered Animals in India’ using PowerPoint. Make these 
changes in the presentation.

•	 Change the background of the slides.
•	 Change font colour.
•	 Apply slide transition. 
•	 Add animations.
•	 Add pictures related to the topic. 

LET'S EXPLORE

•	 Explain to the students that we can make a PowerPoint presentation interesting by 
adding animation and transition effects.

•	 Explain the meaning of animation and transition effects.
•	 Create a presentation and demonstrate the effects discussed in the chapter.

FOR THE TEACHER

EL TE
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Introduction to Excel 20164

LEARNING OBJECTIVES

In this chapter, students will learn about:

Excel 2016—An Introduction 

Starting Excel 

Components of Excel 2016 Window 

Changing the active cell

Creating a New Workbook

Entering Data

Working with Multiple Worksheets

Saving a Workbook

Opening a Workbook

Closing a workbook 

SIGN IN

Read the passage and give the details of Jia’s family in a tabular form.

Hi! My name is Jia. I have a big family. I live with my father, mother, two siblings, 
grandparents, and my uncle’s family. My father is an engineer and my mother is a 
doctor. My grandmother is a teacher and my grandfather is a policeman. My older 
sister is Mia and my younger brother is Max. Uncle Jack is a pilot and his wife, Aunty 
Maria is a nurse. Ann and Ella are my cousins.

Scan QR Code to
watch a video

CM
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Let us learn about Excel, which is a spreadsheet program. 

Excel 2016 is a program that is used to create spreadsheets. A spreadsheet organises text 
and numbers into rows and columns. These rows and columns form a worksheet. 

A worksheet is a collection of cells organized in rows and columns in which we can type 
and store data and perform mathematical functions on it to analyse it. 

In a worksheet, the rows are numbered as 1,2,3,4,5…. Each row has a Row Header on the 
left side of the worksheet which indicates the number of the row. The columns are labelled 
as A, B, C, D, E…. These labels are indicated by Column Headers present at the top of the 
worksheet. Each worksheet of Excel 2016 has 1,048,576 rows and 16,384 columns. 

An Excel file or a spreadsheet file is called a workbook. It has many worksheets. A new 
workbook contains only one worksheet, Sheet 1. The default name of a new workbook is 
Book 1.

Features of Excel
•	 In Excel, the data are set in tabular form.
•	 There are rows and columns and the intersection of rows and columns makes a cell.
•	 Each cell has a cell address. The address is the number of the row and the letter of the 

column it appears in. 
•	 It has built-in formulas and functions to perform mathematical calculations.
•	 The look of the worksheet can be changed by editing and formatting the data.
•	 It is easy to search and replace figures in a spreadsheet.
•	 Data in a series can be easily filled using the AutoFill feature. 

Family Member Name Occupation

In the above exercise, you have entered the information about Jia’s family in a table. 
MS Office has an application that can help us in organizing data in a tabular form easily.
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STARTING EXCEL
Follow these steps to start Excel 2016:

1.	 Click on the Start button.

2.	 Scroll through the program list to find Excel and click on it. The Excel 2016 window will 
appear.

3.	 Click on the Blank Workbook. A blank Excel worksheet will open. 

2

1

3

Microsoft Excel was launched in 1985 by the Microsoft Corporation.

NEWS FEED

COMPONENTS OF EXCEL 2016 WINDOW
The Excel 2016 window has many components. We can use these components to create 
and work with our workbook. Let us learn about these components.

View Bar

Cell

File  
Tab

Tabs Title Bar

Ribbon

Scroll Bar

Columns

Status Bar

Sheet Tab

Rows

Active cell Formula Bar

CM
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Title Bar
It is located at the top of the excel window. It shows the name of the opened workbook file 
and the program. 

File Tab
Clicking on the File tab will open the Backstage. In this Backstage view, we can find a list of 
commands such as save, open, etc. 

Tab
There are nine tabs in Excel 2016. Each tab contains a set of tools that performs a specific 
function. 

Ribbon
It is located below the Title bar and contains different tabs. These tabs are further divided 
into groups which contain many commands tools and buttons. 

Cell
A cell is the intersection of a row and column in a worksheet. It is the smallest unit in a 
worksheet and we enter content here. Content can be text or number.

Active Cell 
An active cell is highlighted by a green border. It is the cell that is currently active or 
selected. We can type data in an active cell only. 

Rows and Columns 
Rows are the horizontal sections of the table and columns are the vertical sections of the table. 

Formula Bar
It shows the contents of the active cell. It is used to type and edit the contents or formulas 
entered in the active cell.

Status Bar
It is located at the bottom of the worksheet window. It displays the name of the selected 
command or the progress of current task.

Sheet Tab
It is located above the Status bar on the left side. It shows the number of worksheets in a 
workbook. The worksheets are named Sheet 1, Sheet 2, Sheet 3, etc. 

View Bar
It is located on the right side of the Status bar. It provides access to view the worksheet in 
three different modes—Normal, Page Layout and Page Break Preview.
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CHANGING THE ACTIVE CELL
The active cell is the cell that is currently active or selected. It has a green border around 
it. The default system is A1. We can make any cell in the worksheet an active cell. We can 
either use the keyboard or the mouse pointer. 

To change the active cell using a mouse, just 
click on the cell you want to make active. 

To change the active cell using a keyboard, use 
the following keys: 

•	 To move the active cell one row down, press 
Enter key or Down Arrow  key.

•	 To move the active cell one row up, press 
Shift + Enter key or Down Arrow  key

•	 To move the active cell one column to the 
left, press Shift + Tab key or Left Arrow  
key.

•	 To move the active cell one column to the right, press Tab key or Right Arrow  key. 

•	 To move the active cell to the first cell, press Ctrl + Home key.

•	 To move the active cell to the last used cell on the worksheet, Press Ctrl + End key.

CREATING A NEW WORKBOOK
Follow these steps to open a new workbook when the Excel application is already running:

1.	 Click on the File tab. A Backstage View will appear.
2.	 Click on New in the left panel. A new pane will appear on the Backstage View.
3.	 Click on the Blank Workbook.

1

2 3

Active cell

The shortcut to open a new workbook: Ctrl + N

QUICK BYTE
CM
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ENTERING DATA
Follow these steps to enter data in a worksheet:

1.	 Click on the cell where you want to enter the data. The cell will become active. 
2.	 Type the content (text or numbers).
3.	 Press Enter key. The content appears in the cell. 

These three buttons next to the formula bar become active when we type in Excel 

Insert function: It is used to insert 
the correct formulas.

Enter button:
It is used to insert  
the text.

Cancel Button: 
It is used to cancel 
the typing task the 
typing task

WORKING WITH MULTIPLE WORKSHEETS
We can open multiple numbers of worksheets. We can switch between them using  
Ctrl + Page Up and Ctrl + Page Down. In a workbook, we can rename, add or remove 
worksheets. 

Renaming
To rename means to change the name of an 
existing worksheet. 

Follow these steps to rename a worksheet:

Method 1

1.	 Right-click on the sheet tab you want to 
rename. A pop-up menu will appear.

2.	 Click on the rename option and type the new 
name for the sheet and press Enter key. 
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Method 2

1.	 Right-click on the sheet tab to be renamed. It 
cursor will appear and it will be highlighted. 

2.	 Type the new name for the sheet and press Enter 
key.

The worksheet will be renamed. 

Adding
We can insert a new worksheet into an existing 
workbook.

Follow these steps to insert a worksheet in the 
workbook:

Method 1

1.	 Right-click on the sheet tab. A pop-up menu will 
appear.

2.	 Click on the Insert option from the menu. An insert 
dialog box will appear. This box has options to 
select worksheet.

3.	 Click on the OK button. 

Method 2

We can also add a new worksheet by clicking on the New Sheet tab icon present next 
to the Sheet tab. 

SAVING A WORKBOOK
Follow these steps to save a workbook:

1.	 Click on the File tab.

2.	 Click on the Save option if you are saving the workbook 
for the first time or saving only the workbook you are 
currently working on. 

	 To save the worksheet with a different name, click on 
Save As option. The Save As pane will appear in the 
Backstage View. 

3.	 Click on the Browse option to select the location to 
save the file. 

2

1

3

1

32
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4.	 In the File name box, type the name of the file. 
5.	 Click on the Save button. 

4

5

It is not possible to name a worksheet ‘History’ in Excel.

NEWS FEED

OPENING A WORKBOOK
Follow these steps to open a save workbook:

1.	 Click on the File tab.
2.	 Click on the Open option from the left pane. The Open dialog box will appear.
3.	 Click on Browse option and select the location where you have saved the workbook.
4.	 Select the workbook you want to open.

1 2

3

CM
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5.	 Click on the Open button. The selected workbook will open in the Excel window.

4

5

CLOSING A WORKBOOK
Follow these steps to close an open workbook:

1.	 Click on the File tab.
2.	 Click on the Close button.
This will close only the current workbook. 

To close the Excel application, click on the Close button  on the right side of the Title bar.

2

1

The shortcut to close Excel: Alt + F4

QUICK BYTE
CM
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ACTIVITY TIME

Find the following words in the given word search.

Ribbon    Cell      Rows    Columns      Workbook      Worksheet      Data
    Header      Spreadsheet      Program        Backstage      Horizontal

      Vertical      Sheet Tab        Default

L C N U D V Q S Z J A T R P C P J H Q O B G R
M E S D S S M S T F J S U B B C R A B G X Z G
L O N T Z T D O L F N K B P W R U C K E E J R
G L I R P E N C U B A R Q Y C A E A G X T B D
M I I E K E P I A M L X V H X H M A Z R Q M V
S L D C S H W H F Y A U D W N E S T E S A A D
N D L E H S R N E I T U G L Y A H E F M H M M
M F A G O K I O D D N T X E R D E E Z V J H Q
U Q C A B R B E P S O E D V G E E H G B N I Z
L N I T A O B F V C Z L N V U R T S C B R N A
O T T S O W O P H X I K A H T N T D E N P V C
C U R K O D N K O C R S W O R A A A L N U Q L
R N E C B U A B T V O D K M F J B E L W T C D
T T V A A F T V O C H L K U Y M T R H D A A T
C X X B Y V A K O O B K R O W J M P O Z I F F
T W Q Z E G D Q V Z W F N K C R N S A B F G Y

•	 Excel is a program that is used to create spreadsheets.
•	 A worksheet is a collection of cells organized in rows and columns.
•	 An Excel file or a spreadsheet file is called a workbook.
•	 We can open multiple numbers of worksheets in a workbook. 
•	 The Excel 2016 window has many components—Ribbon, Tab, Title Bar, File Tab, Cell, 

Rows, Columns, Sheet tab, Status Bar, View Bar, Scroll Bar
•	 A cell is the intersection of a row and column in a worksheet.
•	 The active cell is the cell that is currently active or selected.
•	 An active cell is highlighted by a green border.
•	 We can change the active cell by using the mouse as well as the keyboard.

REFRESH

PL
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BROWSE

A 	 Choose the correct option.

	 1. 	� A new workbook contains  worksheet.

		  a.   one	 	 b.   two	 	 c.   three�

	 2. 	 It is the smallest unit in a worksheet.

		  a.   workbook	 	 b.   cell	 	 c.   sheet�

	 3. 	 Row Header indicates the number of .

		  a.   columns	 	 b.   active cell	 	 c.   row�

	 4. 	 Columns are the  sections of the table.

		  a.   vertical	 	 b.   horizontal	 	 c.   diagonal�

	 5. 	  is used to .

		  a.   add a new worksheet	 	 b.   delete a worksheet�

		  c.   go to the next worksheet	

B 	 Fill in the blanks with the words given below.

	 top            active          Backstage          View          spreadsheet

	 1. 	 MS Excel is a  program.

	 2. 	  will open when we click on the File tab. 

	 3. 	� Column headers are present on the  of the 
columns. 

	 4. 	 Data can be typed only in an  cell.

	 5. 	�   bar provides access to view the worksheet in 

three different modes.
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C 	 Write T for true statements and F for false statements.

	 1. 	 The default name of a new workbook is Book 1. �

	 2. 	 We can use only the keyboard to change an active cell.�

	 3. 	 Ctrl + Home key is used to move the active cell to the last cell.�

	 4. 	 An active cell is highlighted by a blue border.�

	 5. 	 The shortcut key to close Excel is Alt + F4.�

D 	 Answer the following questions in one word or two words.

	 1. 	 Where can you see the name of the opened workbook file?

		

	 2. 	 Where can you see the content of an active cell?

		

	 3. 	 Which cell is highlighted by a green border?

		

	 4. 	 What is the shortcut key to open a new workbook?

		

	 5. 	 When do you use Ctrl + Page Up and Ctrl + Page Down?

		

E 	 Answer the following questions.

	 1. 	 Write any three features of Excel. 

	 2. 	� What is a cell? How would you make a cell an active cell using the keyboard: 
One row down, one row up, one column to the left, and one column to the right? 

	 3. 	 Write the steps to enter data in a worksheet. 

ACTIVITY TIME

LET'S EXPLORE
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	 4. 	 What are the uses of the cancel button, enter button and insert function?

	 5. 	 How would you rename a worksheet? Write the steps.

ACTIVITY TIME

Label any 10 components of the Excel window given below.

Create a worksheet for the fruits given in the picture. Save the file as ‘List of fruits in 
the picture’.

LET'S EXPLORE

6 Lemons 8 Apples 40 Strawberries 7 Bananas

5 Pears 10 Oranges 30 Grapes 2 Watermelons

CM CT

EL TE
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•	 Explain what is Excel and its uses 
•	 Explain the features of Excel.
•	 Show them the different components of the Excel window.
•	 Demonstrate how to change an active cell, create a worksheet, enter data, save and 

close it.

FOR THE TEACHER

24 Raspberries 32 Cherries 36 Blueberries 9 Mangos
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PERIODIC ASSESSMENT 2 

A.	 Fill in the blanks.

	 1.	�   is the slide that is used to create the default layout 
and the appearance of the presentation.

	 2.	� A  icon indicates that the Sound Clip has been added 
to the slide.

	 3.	 Row header indicates the number of .

	 4.	 A new workbook contains  worksheet.

	 5.	 The shortcut key to close Excel is .

	 6.	� A  is a collection of cells organized in rows and 
columns.

B.	 Find the odd one out.

	 1.	 Morph	 Fade	 Push	 Curtains

	 2.	 Drape	 Curtains	 Wipe	 Wind

	 3.	 Fade	 Plan	 Conveyor	 Window

	 4.	 Appear	 Fly in	 Spin	 Float in

	 5.	 Zoom	 Pulse	 Spin	 Teeter

	 6.	 Transition	 Worksheet	 Cell	 Column

C.	 Match the following.

	 1.	 Entrance	 a.	 Spreadsheet 

	 2.	 Subtle	 b.	 Texture for background

	 3.	 MS Excel	 c.	 Horizontal 

	 4.	 Active cell	 d.	 Effects 

	 5.	 Column	 e.	 Transition

	 6.	 Gradient fill	 f.	 Green border
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TEST PAPER 1TEST PAPER 1

A.	 Choose the correct option.

	 1.	�   technology was used in second generation of 
computers.

		  a.  Vacuum tube	 	 b.  Transistor	 	 c.  Chip�

	 2.	�   technology was used in third generation of 
computers.

		  a.  Chip	 	 b.  Transistor	 	 c.  Vacuum tube�

	 3.	  is to change the appearance of a paragraph.

		  a.  Page Breaks	 	 b.  Page Formatting	 	 c. � Paragraph�  
Formatting

	 4.	  is the final step in the mail merge process.

		  a.  Merging the documents	 	 b.  Creating a main document�

		  c.  Creating a data source	

	 5.	 MS Excel is a  program.

		  a.  drawing	 	 b.  spreadsheet	 	 c.  video�

	 6.	�   is the element used in a presentation that 
makes objects move on a slide.

		  a.  Design	 	 b.  Animation	 	 c.  Transition�

B.	 Fill in the blanks.

	 1.	 Analytical engine was invented by .

	 2.	  was the first mechanical calculating device.  

	 3.	� Paragraph spacing refers to the amount of  
space between paragraphs.

	 4.	�   is a collection of words that have similar 
meanings.

	 5.	  is the smallest unit in a worksheet.

	 6.	� A  indicates the animation order in the 
Animation pane.
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C.	 Write T for true statements and F for false statements.

	 1.	 The first generation computers used Vacuum tube technology.�

	 2.	  Mark I was invented by Charles Babbage.�

	 3.	 There are two types of page orientation in Word.�

	 4.	 Word doesn’t have the feature to find and replace words.	�

	 5.	� The look of the theme in PowerPoint can be changed using the  
Variant group. 	�

	 6.	 An active cell is the cell that is currently active or selected.�

D.	 Answer the following in one sentence.

	 1.	 Who is considered as the father of computers?

		

	 2.	 Who is the first lady computer programmer?

		

	 3.	 What is the default paper size in Word?

		

	 4.	 What is the default page orientation in Word?

		

	 5.	 What is a transition?

		

	 6.	 What is the colour of the border of a highlighted cell in Excel?

		

E.	 Answer the following question.

	 1.	 Write a short note on Abacus. 

	 2.	 Write any three features of fifth generation computers. 

	 3.	 What is page orientation in Word? Explain its two types.

	 4.	 What are the main steps of mail merge process?

	 5.	 Write the steps to add an animation.

	 6.	 Write the steps to rename a worksheet.
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Editing in Excel 20165

LEARNING OBJECTIVES

In this chapter, students will learn about:

Selecting cells

Entering date and time in a cell

Editing cell contents

Undo and Redo commands 

Copy and Move contents

Deleting contents of a cell

AutoFill features

SIGN IN

Match the following.

1. 	 	 a. 	 to move one column to the left

2. 	 	 b. 	 to move to the last cell

3. 	 	 c. 	 to move one row down

4. 	 	 d. 	 to move to the first cell

5. 	  + Home	 e. 	 to move one row up

6. 	  + End	 f. 	 to move one column to the right

SELECTING CELLS
We have to select the cell to edit any content in it. We can select only a cell, a row, a 
column, a range of cells, multiple cells or the whole worksheet. 

Scan QR Code to
watch a video

CT
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Selecting a Cell
Follow these steps to select a cell:

1.	 Click on the cell you want to select. A green border will appear around it to show it is 
an active cell.

2.	 To change the active cell, use the arrow keys. 

The selected cell

Selecting a Row
Follow these steps to select a row of cells:

1.	 Position the mouse pointer to the row header of the row you want to select. The mouse 
pointer will change to an arrow.

2.	 Click on the Row Header and the entire row will get selected. 

Row Header
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Selecting a Column
Follow these steps to select a row of cells:

1.	 Position the mouse pointer to the column header of the column you want to select. The 
mouse pointer will change to an arrow.

2.	 Click on the Column Header and the entire row will get selected.

Selecting a Range of Cells
A range is a collection of cells that are selected. They are next to each other and one side 
of their border is common. It can be within a row or column. A range is identified by the cell 
addresses of the cells in the upper left cell and the lower right cell of the range. These 
two addresses are separated by a colon. For example, in the given worksheet the range is 
A1:E5. A1 is the address of the upper left cell and E5 is the address of the lower right cell. 

Column header
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We have to select the range to edit the contents in the range. We can either use the mouse 
or keyboard to select a range.

Follow these steps to select a range using the mouse:

1.	 Click on the upper cell from where you want to start the range.
2.	 Drag the mouse to the lower right cell. 

Follow these steps to select a range using the keyboard:

1.	 Click on the upper left cell.
2.	 Then press the Shift key. Keep pressing and click on the lower right cell.

The range will be selected. All the cells in the range get highlighted except for the active 
cell.

1

2

Selected Multiple Cell
We can select cells that are not next to 
each other. 

Follow these steps to select multiple cells:

1.	 Click on the first cell you want to 
select.

2.	 Keeping the Ctrl key pressed click on 
the other cells you want to select.

	 All the selected cells will be 
highlighted.
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Selecting the Whole Worksheet
To select the whole worksheet, click on the Select All button. This button is the triangle 
present above row 1. 

Select All button

ENTERING DATE AND TIME IN A CELL 
We can enter a date and time in an Excel cell in different ways. We can also change the 
format in any of the available options in Excel.

Date
When we type something like 15-08-22 or 15-8-2022 or 15 August 2022 or August 15, 2022, 
in a cell, Excel reorganises it as a date and displays it in the applied date format to the cell. 

Follow these steps to change the format of the date you have entered:

1.	 Select the cell where you want to edit the date.
2.	 Click on the Home tab.
3.	 Click on the Number format dialog box launcher. A Format cells dialog box will appear.
4.	 Click on the Date option in the Category group. A list of formats will be displayed. 
5.	 Choose and click on the format you want.

The shortcut key to select the whole worksheet: Ctrl + A

QUICK BYTE
CM
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6.	 Click on OK button to change the format. 

1
4

3

The preview of the active 
cell with the selected format 
is shown in the Sample box.

2

5

6

Time
In Excel, the default time format is 
hours:minutes:seconds AM/PM.

When we enter time, we must follow the 
format of at least hours:minutes i.e. the 
hour and minutes are separated by a colon 
with no space on either side. 

Follow the same steps as given above to 
change the time. Click on the Time option 
instead of Date in the Category group.

Click on Time

The shortcut to apply the default date: Ctrl + Shift + #

The shortcut to apply the default time: Ctrl + Shift + @

QUICK BYTE
CM
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EDITING CELL CONTENTS 
We can edit the contents in a cell. To edit means to change the content either partially or 
completely. There are two ways to edit contents in a cell—

•	 by replacing the contents in the cell itself.
•	 by using the formula bar.

Replacing the contents in the cell itself
Follow these steps to replace the contents of a cell:

1.	 Click on the cell to make it active.
2.	 Type the new content. The new content will automatically replace the previous content. 

Using the Formula Bar
The content of a cell can be edited by double-clicking on the cell or using the formula bar.

Follow the following steps to edit the content of a cell:

1.	 Click on the cell you want to edit. The 
content of the cell appears on the 
formula bar. 

	 Or double-click on the cell where you 
want to edit the content. The cursor 
will appear in the cell. 

2.	 Type the new content in the cell or 
the formula bar.

3.	 Press the Enter key on click on the 
Enter button  on the formula bar.

The content of the cell will be changed. 

There are 24 Date and Time functions listed on the drop-down menu under Formulas, 
Date & Time: 11 Date formats and 10 Time formats.

NEWS FEED

1

2

3

Excel has over 475 formulas in its Functions Library, from simple to very complex 
mathematics tasks.

NEWS FEED

CM

CM
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UNDO AND REDO COMMANDS 
The Undo command is used to erase the last change made to the worksheet. Click on the 
Undo button  in the Quick Access Toolbar to undo the last changes. To undo many 
actions, click on the down arrow next to the Undo button.

The Redo command is used to redo the last Undo action. We can redo only when we have 
done an Undo action. Click on the Redo button  in the Quick Access Toolbar to redo an 
action.

COPY AND MOVE CONTENTS
The contents of a cell, a range of cells or the whole worksheet can be easily copied and 
moved. The copy and move commands in Excel are similar to the commands in MS Word. 

Copy Contents
Follow these steps to copy the contents:

1.	 Select the cells you want to copy. In the figure given below, we have selected B2:B3.
2.	 Click on the Home tab.
3.	 Click on the Copy button  in the Clipboard group.
	 Or
	 After selecting the cells, right-click and choose the Copy option from the context menu.
	 You can also press Ctrl + C to copy the cells. 
	 A dashed border will appear around the selected cells. 
4.	 Click on the cell where you want to copy the selected range.
5.	 Click on the Paste button in the Clipboard group.
	 Or right-click and choose the Paste option from the context menu.
	 You can also press Ctrl + V to paste the cells.
	 The copied cells will be copied at the new place. 

1

3
2

5

4

The cells are pasted in the range B11:B12.
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Move Contents
Follow these steps to move the contents:

1.	 Select the cells you want to move. In the figure given below, we have selected B2:E2.
2.	 Click on the Home tab.
3.	 Click on the Cut button  in the Clipboard group.
	 Or
	 After selecting the cells, right-click and choose the Cut option from the context menu.
	 You can also press Ctrl + X to cut the cells. 
	 A dashed border will appear around the selected cells. 
4.	 Click on the cell where you want to move the selected range.
5.	 Click on the Paste button in the Clipboard group.
	 Or right-click and choose the Paste option from the context menu.
	 You can also press Ctrl + V to paste the cells.
	 The copied cells will be moved to the new place.

The cells are pasted in the range B11:E11.

5

2

1

3

4

The shortcut to copy cell: Ctrl + C

The shortcut to paste cell: Ctrl + V

The shortcut to cut: Ctrl + X

QUICK BYTE
CM
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DELETING CONTENTS OF A CELL
We can delete the contents of a cell by using Delete key. Select the cell or the range of the 
cells and press Delete key to delete the contents. The contents of the cells will be deleted. 

We can delete the content of a single cell, a range of cells, a row or a column. 

Deleting cells
Method 1
Follow these steps to delete the cells:

1.	 Select the cells to be deleted.
2.	 Click on the Home tab.
3.	 Click on the Delete button in the Cells group. A drop-down menu will appear. Click on 

the Delete Cells option. 

1

3
2

Method 2
After selecting the cells, right-click on it. Choose Delete option from the context menu that 
appears.

A Delete dialog box appears. It has four options—

•	 Shift cells left: Choose this option to delete the selected 
cells and shifts the cells to the left.

•	 Shift cells up: Choose this option to delete the selected 
cells and the cells shift up.

•	 Entire row: Choose this option to delete the entire row.
•	 Entire column: Choose this option delete the entire 

column.

1.	 Choose the option you want and click on the radio 
button next to it. Here, the option Shift cells left has been 
selected.

1

2
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2.	 Click on the OK button.

The selected cells will be deleted and the 
cells on the right will shift to the left to fill the 
space. In the given figure, the cells move from 
column E to D as the cells in Column D are 
deleted.

Deleting an Entire Row or Column
Follow these steps to delete an entire row or a 
column:

1.	 Click on the Row or Column Header for the cells you want to delete.
2.	 Click on the Home tab.
3.	 Click on the Delete drop-down menu in the Cells group. 
4.	 Choose and click on Delete Sheet Rows to delete a row or Delete Sheet Column to 

delete a column. 

2

1

3 4

The selected row or column is deleted. The row below or the column on the right will shift 
and fill the space. In the picture given below, row 1 is deleted and row 3 shifts to fill the 
space.
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AUTOFILL FEATURE
In Excel, the AutoFill feature helps us to automatically fill a 
series of data in a row or column. AutoFill command can be 
used to automatically extend the sequence of a series of 
numbers, days of the week, months of the year, hours of 
the day, etc.

The mouse pointer changes to a plus sign when we position 
the mouse on the bottom right corner of the selected cell or 
range. This is called the Fill Handle.

Follow these steps to use the AutoFill feature:

Method 1
1.	 Type the first two numbers of the series you want to 

enter.
2.	 Select the cells. 
3.	 Position the mouse pointer at the right corner of the selected cells. Once you see the 

Fill Handle, drag over the cells you want to AutoFill.
4.	 Release the mouse button. The cells are automatically filled with the series. 

2
3 and 4

+

+

Method 2
1.	 Type the first number in the series you want to fill.
2.	 Select the cells that you want to enter the series.
3.	 Click on the Home tab.
4.	 Click on the Fill button in the Editing group. A drop-down menu will appear. 

Fill Handle

+
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5.	 Click on the Series option from the menu. A series dialog box will appear. 
6.	 Click on the OK button. The cells are filled with the series. 

3

1

2

5

The numbers are 
auto filled.

+

4

ACTIVITY TIME

Write the shortcuts.

1. 	 To copy cell	�

2. 	 To apply the default date�

3. 	 To select the whole worksheet�

4. 	 To apply the default time�

5. 	 To cut cell�

•	 A cell has to be selected to edit any content in it.
•	 A range is a collection of cells that are selected. 
•	 Click on the Select All button to select the whole worksheet.

REFRESH

CM
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BROWSE

A 	 Choose the correct answer.

	 1. 	� It is a collection of cells. 
		  a.  � Rows and	 	 b.   Group of cells	 	 c.   Range�  

Columns

	 2. 	 The shortcut key to select the whole worksheet.

		  a.   Ctrl + A	 	 b.   Ctrl + Z	 	 c.   Ctrl + Q�

	 3. 	 The shortcut to apply default date. 

		  a.   Ctrl + shift + # 	 	 b.   Ctrl + shift + %	 	 c.   Ctrl + shift + !�

	 4. 	 In Excel, the default time format is

		  a.   minutes:seconds:hours AM/PM	

		  b.   hours:minutes:seconds AM/PM	

		  c.   seconds:minutes:hours AM/PM	

	 5. 	 The shortcut to apply default time.

		  a.   Ctrl + Shift + !	 	 b.   Ctrl + Shift + @	 	 c.   Ctrl + Shift + #�

B 	 Fill in the blanks using the words given below.

	 Ctrl + V          AutoFill            MS Word          Formula          Undo

	 1. 	 We can edit the contents in a cell by using the  bar. 

	 2. 	� The  command is used to erase the last change 

made to the worksheet.

•	 Date and time can be entered in an Excel cell in different ways. 
•	 The contents in a cell can be edited by replacing the contents in the cell itself or by 

using the formula bar.
•	 The AutoFill feature helps us to automatically fill a series of data in a row or column.
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	 3. 	 The shortcut to paste a cell is  . 

	 4. 	� The copy and move commands in Excel are similar to the commands in 

. 

	 5. 	� The  feature helps us to automatically fill a series 

of data in a row or column. 

C 	 Write T for true statements and F for false statements.

	 1. 	� To select a row, position the mouse pointer on the column header.�

	 2. 	 An active cell has a blue colour border around it.�

	 3. 	� In the range A1E5. A1 is the address of the upper left cell and E5  
is the address of the lower right cell.�

	 4. 	 We cannot select multiple cells in Excel.�

	 5. 	 To delete the contents of cells, select the cell and press the Esc key.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	 Which key is used to change active cell?

		

	 2. 	 Which key is used to select a range of cells?

		

	 3. 	 Which key is used to select multiple cells?

		

	 4. 	 What is the shortcut to select the whole worksheet?

		

	 5. 	 Which key is used to erase the contents of a cell?
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E 	 Answer the following questions.

	 1. 	 How would you select a column? Write the steps.

	 2. 	 Write a short note on range.

	 3. 	 What is AutoFill feature?

	 4. 	 What are the uses of Undo and Redo commands?

	 5. 	 How would you delete an entire row or column? Write the steps.

ACTIVITY TIME

Solve the puzzle.

1. 	� If A2 is the address of the upper left cell and E6 is the address of the lower right 

cell. What is the range? 

2. 	 If the active cell is A7, what is the location of the two cells above it? 

	

3. 	 �If B5 is the address of the upper left cell and G7 is the address of the lower right 

cell. What is the range? 

4. 	 If the active cell is B7, what is the location of the cell on the right of it?  

	

5. 	 If the active cell is G7, what is the location of the cell on the left of it? 

	  

CMCT
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In your computer lab, create and format the clothes shopping budget with a chart.

The allowance is ₹ 10,000 and the total expenses are ₹ 10,500. The expenses need to be 
modified. 

Format the chart as followed:

•	 Insert serial number in Column A. Start from A4.
•	 Edit the cell C8, make it ₹ 1000.
•	 Edit the cell C10, make it ₹ 10000.
•	 Enter the date and time of formatting the chart.

LET'S EXPLORE

•	 Recapitulate the basics of Excel.
•	 Help the students in using various Excel editing features.

FOR THE TEACHER

EL TE
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Internet and Email6

LEARNING OBJECTIVES

In this chapter, students will learn about:

Internet

Requirements for connecting to the Internet

Types of Internet connections

Web browser

Using URLs

Email  

Email etiquettes

1.	  
SIGN IN

Are these actions good or bad? Discuss.

•	 Putting pictures of your friends on the Internet without their permission
•	 Not to log out or sign out after you finish
•	 Sending bad messages about friends
•	 Sharing your pictures online with people you do not know

In the previous classes, we have learnt that the Internet is a well-connected network of 
computers all over the world. Through the Internet, we perform many activities and are 
connected with people all over the world. In this chapter, let us learn how we can connect 
and use the Internet.

Scan QR Code to
watch a video

SEL CM
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INTERNET
The Internet is a global network that connects 
millions of computers and computer networks all 
over the world. It contains websites and web pages 
that provide us with information on almost any 
topic. 

The full form of the Internet is Interconnected 
Network. 

Uses of Internet
Today, Internet is used in various fields of our daily life. These are some of the various 
applications of Internet. 

Social Networking

Job Search

Shopping

Browsing

Travel

Communication

Payments

E-Commerce

REQUIREMENTS FOR CONNECTING TO THE INTERNET
The basic things required for connecting to the Internet 
are: 

A Computer System or a device
A computer or any device similar to a computer such 
as a mobile phone is important to connect to the 
internet. The device connected to the Internet can be 
used to easily access the information available around 
the world. It is only through the device we can access a 
web browser.

A Telephone and Cable Line
Telephone and cable lines are used to set up a link 
between different computers and servers.
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A Modem or a network card
A modem is to transmit digital information through telephone lines 
and back. The full form of modem is Modulator-Demodulator.

A modem is of two types: Internal and External modem.

A company providing Internet Connection (ISP)
An ISP is a company that provides us with the 
internet at a particular fee. BSNL, Airtel, Vodafone, 
and Reliance Communications are some of the 
Internet Service Provider companies. 

The full form of ISP is Internet Service Provider. 

Web Browser
A web browser is application software used to access 
information on the Internet. It helps us to retrieve information 
from different websites and web pages. 

There are a number of web browsers. Some of the popular are 
Google Chrome, Microsoft Edge, Apple Safari, Mozilla Firefox and 
Opera. 

TYPES OF INTERNET CONNECTION
There are several ways to connect our devices such as laptops, 
computers, smartphones, and tablets to the Internet. We can connect to the Internet using 
different broadband technologies including satellite cable, telephone wires, and wireless or 
mobile connections. Some of the most commonly used Internet connections are discussed 
below. 

Dial-Up
A Dial-Up connection links the phone line to a 
computer to get access to the Internet. It is the 
most basic type of Internet connection. 

The disadvantage of this type of connection is that 
the phone line cannot be used to make calls if it is 
being used to connect to the Internet. 

Broadband
A broadband connection is provided through cable or 
telephone companies. It is a high-speed Internet connection 
and faster than a dial-up connection. Through broadband, 
we can share a large amount of data. It includes several 
high-speed transmission technologies such as Digital 
Subscriber Line (DSL) and Cable Modems. 

Microsoft 
Edge

Internet 
Explorer

Mozilla 
Firebox

Opera SafariGoogle  
Chrome
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Wi-Fi
A Wi-Fi connection allows users to connect to 
the Internet wirelessly. It uses radio frequency to 
connect to the Internet. Wireless connections are 
only possible through the modem which recognizes 
Internet signals and sends them to computers. 

The advantage of a wireless connection is that it is 
an ‘always on’ connection and it can be connected 
from anywhere as long as the device falls into its 
network range. 

Mobile Internet
The Internet can be accessed through Internet-
enabled mobile phones. Usage of the Internet using a 
cellular telephone service provider is known as Mobile 
Internet. It is a wireless Internet connection access 
through mobile networks. The main advantage of 
the mobile internet is that we can always access the 
Internet even if a computer is not nearby. 

Hotspots 
Hotspots are sites that offer Internet access. Sharing a connection from one phone to 
other phones, tablets or computers is called using a hotspot. Most smartphones can share 
mobile data through hotspots. 

WEB BROWSERS
A web browser is an application software 
used to explore and access information 
on the World Wide Web. To open a web 
browser, we need an Internet connection. 
Once the device is connected to the 
Internet, follow these steps to open the  
web browser: 

1.	 Click on the Start button.
2.	 Scroll down the programs list and click 

on the browser, Microsoft Edge. 
	 A web browser window appears.

2

1
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USING URLs
URL is the address of a web page. Every web page has a specific Uniform Resource 
Locator or URL. When the URL of a particular website or a web page is typed into the 
search engine of a web browser, the web browser finds it and displays it on its window.

Follow these steps to open a website or a web page:

1.	 Open the web browser.
2.	 Type the URL in the web browser’s address bar. 
3.	 Press the Enter key. 

For example, if you want to know about UNICEF, type www.unicef.org in the address bar 
and then press Enter key. The home page of the website of UNICEF will appear on the 
browser window. 

Home page of the website of UNICEF

Microsoft Edge window
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EMAIL 
Email stands for electronic mail. It is a system of It is used to send 
messages to other people, just like postal mail. But in the case of emails, 
we send and receive the mail through a device such as a computer or 
a smartphone that is connected to the Internet. It is one of the most 
widely used services of the Internet.

Advantages of email
An email can be used for various purposes. Some of the advantages of email are:

•	 It is one of the fastest and most economical forms of communication. We can send and 
receive an email in a minute. 

•	 Through emails we can send not only text but also image, audio and video messages. 
•	 It can be used to communicate with a large number of people. 
•	 Email is environment-friendly because we do not use any paper or pen. 
•	 It can be sent and received in many places and at any time of the day. 
•	 The chances of the mail getting delivered to the wrong person are very less.
•	 If a mail fails to get delivered, we are instantly alerted of it so we can send another mail. 

Email Address
If someone wants to send you something to your home. How will they do it? They will post 
the mail to your home address. Similarly, to send or receive an email, you need to have an 
address. This address is called an electronic address or email address. 

An email address is a name that you use to send and receive emails. Here are some email 
addresses:

	 alex@yahoo.com

	 riasing@gmail.com

An email address contains a username 
and a domain name and they both are 
separated by a ‘@’. The portion before the 
‘@’ is the username and the portion after 
‘@’ is the domain name. The username is 
unique to everyone. The most standard and 
recommended form is to use the first name 
or first name and last name together as a 
username. The domain name is common for 
everyone. The domain name uses a specific 
network for sending or receiving mail. 

riasing@gmail.com

username Domain name

at

dot
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Saying email addresses
Remember these when we say an email address:

•	 @ is pronounced as ‘at’.
•	 . is pronounced as ‘dot’.
The email address riasing@gmail.com is read as ‘riasing at Gmail dot com’.

All email addresses follow the same format abc@domainname.com since 1980s. 

NEWS FEED

Creating an Email Account
Many websites allow you to create an email account for free. For example, Hotmail, Gmail, 
Yahoo, etc. An email account can be opened with any of these service providers.  The most 
common email service provider is Gmail. 

Follow these steps to open an email account:

1.	 Connect your device to the Internet. 
2.	 Open the web browser, Microsoft Edge.
3.	 In the address bar, type the URL, www.gmail.com and then press Enter. The home 

page of Gmail will open. 
4.	 Click on Create an account option. It will open a window asking for various details. 
5.	 Fill in the details. 

•	 First name: Type your first name in this field. 
•	 Last name: Type your last name in this field.
•	 Username: Type the words you want to create your account with. 

URL
4

CM
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94 Chapter 6 I Internet and Email

	 You can use your first name, a combination 
of your first and last name or you can use 
something else. If the username you choose is 
already taken, it will inform you and give you 
several options similar to the username that 
you chose.

•	 Password: A password is used so that nobody 
else can access your email and send unwanted 
emails. Type a strong password that you can 
remember. A password for a Gmail account 
should contain 8 or more characters which 
should be a combination of letters, numbers 
and special characters. 

6.	 Click on the Next button to continue. 

	 The next page opens a screen that asks for 
various details. It asks for a phone number, 
a recovery email address, your birthday and 
your gender. Phone number and recovery mail 
address are optional so you can skip that if you 
choose. 

7.	 Enter a phone number and email address.
	 Take permission from your parents or 

any adult whose phone number or email 
address you would be using. 

8.	 Click on the Next button to continue.
	 Enter the verification code sent to the 

phone number or email address provided 
by you in the previous step. 

9.	 Click on the Verify button. 
	 Google displays a list of terms and 

conditions. Read it yourself and have 
your guardians go through the terms and 
conditions as well. If your guardian agrees 
with the terms and conditions, then you can 
continue. 

10.	 Click on the I agree button to continue. 

7

8

10

9

5

6
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95Chapter 6 I Internet and Email

The welcome screen of your personal Gmail account will open.

Gmail account window

The phone number entered while creating an account can be used to reset the 
password in case we do not remember the password.

NEWS FEED

Signing In
Signing in to an account means to access the account. We can sign in to an account from 
anywhere if we have an Internet connection on our devices. 

Follow these steps to sign in to your account:

1.	 Open the web browser. 
2.	 Type the URL www.gmail.com in the address bar and press Enter key.
3.	 In the Email or phone field, enter the username that you have created. 

3

4

5

CM
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4.	 Click on the Next button.
	 A new window will open asking for the password. 
5.	 Enter the password in the Password field and then click Next button.
	 Your email account will open. 

Sending an Email
Let us learn how to send an email using the account you have 
created. First, take the email address of the person you want 
to send an email.   

Then, follow these steps to send the email:

1.	 Click on the compose present on the left side of the 
window. 

	 A New Message window will open on the screen. 
2.	 Type all the information needed in the message window. 

The message window has many fields: 
•	 To: In this space, type the mail address of the person 

you want to send the mail to. We can enter more than 
one email. The email addresses are separated by a 
comma (,).

•	 Cc: CC stands for Carbon Copy. The person whose address is typed here is not the 
direct recipient of the mail. It is to inform him/her that the mail has been sent to the 
person marked in the To field.

•	 Bcc: BCC stands for blind carbon copy. 
The address entered in this field will be 
hidden from the other persons you have 
sent the mail.  

•	 Subject: The section is to introduce the 
purpose of writing the mail. 

•	 Body: In the white empty field below 
the subject line is where you type the 
message. 

•	 Toolbar: There are several other options 
below the body of the message where 
you can do various tasks. For example, 
attach files, add images or emojis, etc.

3.	 After you finish writing your mail, click on Send. 

1

3
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Reading an Email
The Emails you have received will appear on the first window that appears when you Sign 
in or Log in. The number of unread emails is displayed in front of the word ‘Inbox’. The 
unread emails appear in bold. All the emails that you get are displayed on the mail window 
in Inbox. Click on the name of the sender or the subject to read the email. 

An email account window

Number of unread 
emails

Sign Out
It is very important that the email account is properly 
closed after using it so that nobody else can use it to 
send unwanted emails. Closing an email account after 
completing our work is called Sign out. 

Follow these steps to sign out of your email account:

1.	 Click on the icon with the first letter of your name. It is 
present in the top right corner. 

2.	 Click on the Sign out button and it will close your 
account. 

EMAIL ETIQUETTES
When we meet someone, there are certain accepted behaviours and actions that we have 
to follow. When we meet people online, we have to follow the same basic etiquette and be 
polite even if we not meeting the person face to face. 

Some of the etiquettes that we should follow while using emails or social networking sites are: 

•	 While writing an email, the message should be conveyed clearly so that the receiver 
does not have any problem understanding it. 

•	 We should not write a message in capital letters as it implies shouting at the person.
•	 A mail should always begin with a proper greeting. 
•	 The subject of the mail should be specific so the other person reading the mail knows 

what it is going to be about. 

1

2

Computer G5_Ch-6.indd   97Computer G5_Ch-6.indd   97 27-02-2023   11:33:0127-02-2023   11:33:01



98 Chapter 6 I Internet and Email

•	 Use the Bcc feature if you are sending the same email to multiple people. 
•	 Go through the message before sending it.
•	 Check spelling and grammar errors.
•	 Do not click on any web link sent by someone you don’t know.
•	 Open only the attachments that come from a trusted source. 
•	 Always sign out when you are done using your account.

ACTIVITY TIME

Identify and write what they are.

1. 	 www.google.com�

2. 	 aakash@yahoo.com�

3. 	 Google Chrome�

4. 	 Airtel�

5. 	 BSNL�

•	 The full form of the Internet is Interconnected Network.
•	 The Internet is a global network of computers.
•	 The things required to connect to an Internet connection are a device, telephone and 

cable lines, modem, web browser and ISP.
•	 There are several kinds of Internet connections.
•	 In a Dial-up connection a phone line is used to connect to the Internet.
•	 Cable is not required in a Wi-Fi connection.  
•	 URL stands for Uniform Resource Locator and is the web page address. 
•	 The full form of email is Electronic Mail. 
•	 An email is used to send messages to other people electronically. 
•	 An email account is required to send and receive messages electronically.
•	 An email address contains a username and a domain name. 
•	 It needs to sign in to your email account to read a message you have received. 

REFRESH

CM
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BROWSE

A 	 Choose the correct option.

	 1. 	� A web browser is .

		  a.   domain name	 	 b.   an application to access websites�

		  c.   an ISP	

	 2. 	� Opera and Mozilla Firefox are examples of .

		  a.   An IPS	 	 b.   a URL	 	 c.   a web brows�

	 3. 	� In the email address abc@gmail.com, the domain name is 

.

		  a.   smile	 	 b.   @ 	 	 c.   gmail�

	 4. 	� In the email address mary23@gmail.com, the username is 

.

		  a.   gmail	 	 b.   .com	 	 c.   mary23�

	 5. 	 @ in an email address is read as .

		  a.   as	 	 b.   at	 	 c.   an�

B 	 Fill in the blanks using the words given below.

	 carbon copy            Gmail            URL            Dial-up            email

	 1. 	 Electronic mail is the full form of .

	 2. 	  stands for Uniform Resource Locator.

	 3. 	 CC stands for .

	 4. 	  is a type of Internet connection. 

	 5. 	  is an email service provider.
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C 	 Write T for true statements and F for false statements.

	 1. 	 Emails are delivered instantly.�

	 2. 	� Only one name can be entered in the To field while composing  
an email.�

	 3. 	 Signing in to an account means closing the account. �

	 4. 	 We should not share our password for email accounts with anyone. �

	 5. 	� We should not sign out from our email account after we complete  
our work.�

D 	 Answer the following question in one word or one sentence.

	 1. 	 Give one example of an Internet connection. 

		

	 2. 	 Name two web browsers.

		

	 3. 	 Name two ISPs.

		

	 4. 	 Give one example of a URL.

		

	 5. 	 Give one example of an email address.

		

E 	 Answer the following questions.

	 1. 	 Define the term Internet. Write some uses of it.

	 2. 	 Describe the things required for an Internet connection. 

	 3. 	 Explain the types of Internet connection. 
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	 4. 	 Differentiate between the BCC and CC fields of the message window. 

	 5. 	� List some etiquettes that should be followed while using social  
networking sites.

ACTIVITY TIME

Find the following words in the puzzle. Words are hidden     and .

Internet          Hotpots          Vodafone          Password          Message      Electronic
  Attachment        Username          Address          Mail        Browser          Modem

W E S B A E Y S K E U J S T O P T O H N D F Y

Z U S D T U L Q J L B R C X P Y H K P X L Y V

X D M R H B G E B D M O E I J A R K L V E K U

W J W E U A X T C R R Z C J F W N Y B N H H T

E W T T W H B N O T O G F S H A Z U M K I F N

A L I V I B L E G M R W C H U D V P I W E R B

P S F Z K L I M X Z N O S D O D N L T D N S T

T A F K B C D H R V W K N E D R O I O A O H R

P K S D N B G C E S N H P I R E U A G T F U D

N K V S H F F A G Q p K B T C S J M D E A A A

R Q Q H W B H T A A O O C I G S M M Y N D X H

M L B O B O M T S K N P J S Y D A Z J R O O S

F C X C G R R A S G N Q K G O L T D F E V J N

F Z U L G M E D E U E G Q Y E S A Z I T R M A

F Z U S E R N A M E W T K U K O W Y W N L E L

N D F Z E P C O M E D O M K L U X Q S I F T I

Do these activities in the computer lab.

•	 You have learnt how to create an email account. Now, with the help of your teacher, 
create your email account.

LET'S EXPLORE
EL TE

PL
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102 Chapter 6 I Internet and Email

•	 Recapitulate the uses of the Internet discussed in the previous classes.
•	 Demonstrate how to create an email account.
•	 Show them how to send and read an email.
•	 Discuss the etiquettes to be followed while using email and social networking sites.

FOR THE TEACHER

•	 Using the account you have created, create an email telling your friend about your visit 
to your grandparent’s home during summer vacation. And mail it to your friend.
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Data Processing7

LEARNING OBJECTIVES

In this chapter, students will learn about:

Data and information

Data sorting

Information representation

Decoding

SIGN IN

Look at the pictures and write the names of the objects in the correct column.

Lamp

Oven

Television

Rocking Chair

Refrigerator

Kettle

Bookcase

Sofa

Toaster

Rice Cooker

Scan QR Code to
watch a video

CM CR

Computer G5_Ch-7.indd   103Computer G5_Ch-7.indd   103 23-02-2023   13:29:4323-02-2023   13:29:43



104 Chapter 7 I Data Processing

DATA AND INFORMATION
Data is a collection of facts that is unorganized. It needs to be arranged to make it 
meaningful. 

Information is the meaningful outcome we get after processing, organising or presenting 
the data in a given context. 

For example, the test score of each student for different subjects is data. From this data, 
we can find out the least-scoring or highest-scoring subject. This is the information. 

From the data given in the above table, we can get the information that maths is the  
least-scoring subject for the students and English is the highest-scoring subject. 

Name Maths English Science Social Science

Danish 50 80 70 76

Ajay 69 88 85 70

Maya 51 92 70 79

Ishita 70 85 76 81

Asad 66 93 81 69

Things you see in the kitchen Things you see in the living room

1. 1.

2. 2.

3. 3.

4. 4.

5. 5.

It is easy to get the required information if the data is represented in a neat and organised 
manner such as the table. 

DATA SORTING
Data needs to be arranged to get the information we are looking for. Data sorting is 
organising and arranging data into meaningful order to make it easier to understand and 
analyse. 
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Look at the picture given below. If you have to arrange the items in ascending order, how 
will you do it? 

First, make a table and write the number of each item.  

Name of the item Number

1.	 Boots 9

2.	 T-shirt 3

3.	 Coat 7

4.	 Umbrella 8

5.	 Hat 2

From the data given in the table, we can get the required information by organizing or 
arranging it.

Now, arrange the number of items in ascending order.

Name of the item Number

1.	 Hat 2

2.	 T-shirt 3

3.	 Coat 7

4.	 Umbrella 8

5.	 Boots 9
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INFORMATION REPRESENTATION
There are many ways to represent information. Let us look at some ways through which 
information is represented. 

Tables 
We can represent information in the form 
of a table. 

In a table, information or data is 
arranged in rows and columns. The way 
information is represented in table form 
is called a tabular format. 

The school timetable is an example of 
representing information in a tabular 
format. 

Pictograms
We can represent information in the form of pictograms. A pictogram is a way of 
representing information or data using images, icons or symbols. 

These are some of the commonly used pictograms.

A format of school timetable

	 Do not use phone	 No Left-turn	 Pedestrian Crossing	 Deer Crossing

The word ‘Data’ derives from the Latin word ‘datum’ (singular) which meant 
‘something given’.

The word ‘Information’ derives from the Latin word ‘datum’ (singular) which meant 
‘something given’.

NEWS FEED
CM
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The sign ‘Dear Crossing’ on the side of the road informs people about deer crossing the 
road. 

Maps
We can represent information in 
the form of maps. A map presents 
information about a place in a simple 
visual way. Through a map, we can 
know the shape and size of countries, 
the distances between places and the 
special locations of a place.

A map continents of the world

Pictures
We can represent information in the form of pictures and drawings. A picture helps us learn 
and explain tough concepts in an easier way. A picture is able to grab our attention and we 
can remember what we see in a picture for a longer period. 

A picture showing the stages of the life cycle of a butterfly
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ACTIVITY TIMEDECODING
Decoding is the process of converting 
code into text or a format of a language 
that is easy to understand. 

Read what the girl is saying to the boy.

Do you understand what the girl is 
saying? She is talking in a code. How 
will we know the message hidden in 
the code? We have to decode it to 
understand its meaning using the given 
letter/number key.

19  12  6  26  9   
22  2  12  6?

A B C D E F G H I J

26 25 24 23 22 21 20 19 18 17

K L M N O P Q R S T

16 15 14 13 12 11 10 9 8 7

U V W X Y Z

6 5 4 3 2 1

To decode the above message, replace the numbers with the letter of the same position in 
the letter/number key chart.

	 19  12  6	 26  9  22	 2  12  6

	 H   O  W	 A  R  E	 Y  O  U

The message in the given code is ‘How are you?’

The method by which information is converted into secret code is called encryption. 
The science of encrypting and decrypting information is called cryptography.

NEWS FEED
CM
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ACTIVITY TIME

Using the letter/number key chart, decode the following.

1. 	 19 22 15 15 12	

2. 	 20 12 12 23  14 12 9 13 18 13 20	

3. 	 24 12 14 11 6 7 22 9	

•	 Data is a collection of facts that is unorganised. 
•	 Information is organized or arranged data. 
•	 Data sorting is arranging and organising data to make it easier to understand. 
•	 Information can be represented in many ways. 
•	 Decoding is the process of converting a coded message into a format that can be 

easily understood.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	� It is the unorganised facts. 

		  a.   Information	 	 b.   Data	 	 c.   Decode�

	 2. 	 It is the outcome of organised data.

		  a.   Data	 	 b.   Sorting	 	 c.   Information�

	 3. 	 It gives the information in a neat and clean format?

		  a.   Maps	 	 b.   Tables	 	 c.   Pictograms�

	 4. 	 It presents information about a place visually.

		  a.   Pictograms	 	 b.   Maps	 	 c.   Pictures�

CMCT
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B 	 Write T for true statements and F for false statements.

	 1. 	 Data and Information are the same.�

	 2. 	 We get data from the information.�

	 3. 	 We get the required information after arranging the data.�

	 4. 	 We can represent information in only one way.�

	 5. 	 Decoding is writing a message in code.�

C 	 Answer the following questions in one word or two words.

	 1. 	 What do you call the representation of information in the form of a table?

		

	 2. 	� What do you call the representation of information using images and icons?

		

	 3. 	� What do you call the process of converting a coded message into an 
understandable format?

		

D 	 Answer the following questions.

	 1. 	 What is the difference between data and information?

	 2. 	 What is data sorting?

	 3. 	 Write some of the ways through which we represent information.
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ACTIVITY TIME

1. 	 Decode the words.

2. 	� Collect data from your classmates to find the most popular sport in your class.

	 	 a.   Record the data in a table. 

Sport Cricket Football Swimming Basketball Other

Number of 
students

		  b.   Arrange the data in descending order.

Sport Number of Students

1.

2.

3.

4.

5.

•	 Which is the most popular sport in your class?�

•	 Which is the least popular sport in your class?�

CMCT
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1. 	 �In the computer lab, browse through the Internet and find out the meaning of 
these pictograms.

LET'S EXPLORE

1. 	 2. 	 3. 	 4.

5. 	 6. 	 7. 	 8.

2. 	 Discuss which of these can be used in or around a school. 

•	 Explain with an example the difference between data and information.
•	 Explain the concept of secret messages.
•	 To reinforce the concept, play a game where a student has to create a coded 

message and another student have to decode it.

FOR THE TEACHER

EL TE
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PERIODIC ASSESSMENT 3 

A.	 Look at the pictures and write the missing labels.

alex@yahoo.com

6.5.

1.

3.

2.

4.

B.	 Fill in the blanks.

	 1.	 In Excel, a  has to be selected to edit any content in it.

	 2.	  is a collection of facts that is unorganised.

	 3.	  presents information about a place virtually.

	 4.	 Google and Safari are examples of .

	 5.	  are delivered instantly. 

C.	 Match the following.

	 1.	 Range	 a.	 Web browser

	 2.	 Ctrl + A	 b.	 Email address

	 3.	 Google	 c.	 A way to represent information

	 4.	 abc@gmail.con	 d.	 Collection of cells 

	 5.	 AutoFill	 e.	 Select the whole worksheet 

	 6.	 Pictogram	 f.	 Excel
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Conditional Programming in 
Scratch8

LEARNING OBJECTIVES

In this chapter, students will learn about:

Shapes of blocks in Scratch

Learning the Sensing Blocks

Variables

Understanding conditional programming

Creating a project

SIGN IN

Find 10 words related to Scratch. Words are hidden ,  and .

G B M T R M O T I O N O P T F E R U
I V E M S O U N D H W Z T L Y Q L I
B B K T N A R E V D Q R Z O V H V H
X L A C Y Y L P M O W Z H O G L X A
S R O C O F H Z L J O K V K Y Y K K
R F B C K N Z B G W X N L S S V Q E
N N K V K D T O E V E N T S P Q P T
E W U Z C Y R R L A P U O W R H R G
F W T O D E L O O M T S C R I P T K
F O Z U F V A J P L G O K K T A Q R
Q F Y R S T A G E S U Z Z B E C Q J
D S M G Q V J W F D H J O A I I Y R

Scan QR Code to
watch a video

PL
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SHAPES OF BLOCKS IN SCRATCH
Blocks in scratch are made up of different shapes. They can be grouped into six types—
Hat, Stack, Boolean, Reporter, C and Cap.

Hat Blocks
A Hat block looks like a hat. Hat blocks are designed to start a script. These blocks always 
come on top of the script like a hat. We cannot put any other block on top of them. All the 
hat blocks are either Control blocks or Events blocks. 

Some of the Hat blocks that we can find in Scratch

Stack Blocks
A Stack block is a rectangular block with a cut of bowl shape at the top and a bump at the 
bottom. Stack blocks are designed to fit above and below other blocks. They formed the 
majority of the blocks available in scratch. These blocks are used to run commands.

Some of the Stack blocks that we can find in Scratch

Boolean Blocks
A Boolean block has pointy ends and looks like an elongated hexagon. Boolean blocks 
represent one of two outcomes—‘true’ or ‘false’ or the number ‘0’ or ‘1’ depending on their 
usage in the script.

Some of the Boolean blocks that we can find in Scratch
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Reporter Blocks
A reporter block has rounded edges. Reporter blocks report a value. This value can be 
numbers or strings. For example, we get the value for 6 – 3 as 3. 

Some of the Reporter blocks that we can find in Scratch

C Blocks
A C block has the shape of the letter C. Other blocks can fit inside a C block. C blocks are 
also known as wrap blocks. They perform loops and conditions. These blocks are present 
in the control category. 

Some of the C blocks that we can find in Scratch

CAP Blocks
A CAP block ends the scripts. CAP blocks are shaped with a notch at the top and a flat 
button. We cannot place other blocks below them. They are the last block in a script. There 
are two CAP blocks and they can be found in Control group. 

CAP blocks that we can find in Scratch

On March 5, 2007, the oldest existing Scratch project, Weekend, was uploaded.

NEWS FEED

LEARNING THE SENSING BLOCKS 
Sensing blocks in Scratch are used to detect different factors of a project such as location 
of the mouse-pointer, distance from other sprites and whether a sprite is touching other 
sprite. Sensing blocks are colour-coded light blue. There are 18 Sensing blocks in Scratch 
3.0. Let us learn about some of the sensing blocks and their functions. 

CM
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117Chapter 8 I Conditional Programming in Scratch

This block checks if the sprite is touching the  
mouse-pointer, edge, or another sprite. If the sprite is 
touching the selected object, then it executes the block 
given after it in the condition. If it is not, it executes 
other blocks as per the given condition.

This block checks if the sprite is touching a specific 
colour. If it touches, then it executes a set of blocks. 
If not, it executes another set of blocks. 

This block checks if the first colour is touching the 
second colour. If it touches, then it executes a set of 
blocks. If not, it executes another set of blocks.

This block will make the sprite using the block to 
ask a question and prompts the user to type the 
input using the keyboard. No other block runs at 
that time as it waits for the user input. 

To understand the working of sensing blocks, let us create a script. 

Follow these steps to add sensing blocks to the script:

1.	 Click on the Sensing block category in the Code tab.
2.	 Delete the cat sprite and insert a different sprite, Abby.
3.	 Add a new backdrop to the stage, Baseball 1.
4.	 Drag the Ask block to the script area and click on it. A speech bubble will appear above 

Abby with the text ‘What’s your name?’ 
	 An input box with a blinking cursor will also appear on the stage. 
5.	 Type your name in the input box. Click on the tick button or press the Enter Key. The 

name will disappear.

3

1

2
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118 Chapter 8 I Conditional Programming in Scratch

6.	 Click on the check box before the answer block. The answer will display on the stage.

To make Abby speak the name for a given number of seconds, follow these steps:

5

6
4

•	 Place the Answer block from the Sensing block in the Say block from Looks block. 

•	 Now snap this block to the Ask block and click. Abby will speak the name for 2 seconds.

The question in the ask block can be changed according to our choice. To change the 
question, click on the type box and type the question. 

VARIABLES
All the computers need a program to carry out a task. A program is a group of commands 
and instructions that tell a computer what task to do. In Scratch, blocks are the commands 
or instructions that are given to the sprite to perform a task. These blocks form a script. 
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119Chapter 8 I Conditional Programming in Scratch

We use data such as numbers, text, dates and pictures in a program. This data is stored in 
variables. Variables are used to hold values. The values of this variable are not fixed. The 
value can be modified according to the script. For example, in the turn block, by default, 
the variable has a value 15. We can modify this value according to the script.

Variables are of two types—numeric variable and string variable.

A numeric variable is a variable that stores numbers. For example, 10, 784, 999, 89765, etc. 
These variables are used in calculation.

A string variable is a variable that stores letters in the form of strings or characters. The 
values of string variables may include names, words, sentences and numbers. The values 
are enclosed in quotation marks. For example, “Hello”, “I am a girl”, “10”, “Number 1”, etc.

Creating Variables in Scratch
Follow these steps to create variables in Scratch:

1.	 Click on the Variables block category. A set of blocks will appear in the block palette.
2.	 Click on the Make a Variable block. A New Variable dialog box will appear. Enter the 

name of the new variable in the New variable name box. 
3.	 Choose and click on the radio button of either of the two given options.

•	 Click on For all sprites to make the variable appear for all the sprites.
•	 Click on For this Sprite only to make the variable appear for only this Sprite.

4.	 Click on the OK button.
	 The variable will appear in the list of Variables blocks.

	 Variables Blocks	 New variable dialog box

4

3

1
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120 Chapter 8 I Conditional Programming in Scratch

We have added the variable animal and chose For all sprites. 
This variable will be available for all the sprites.

Now, let us create a script using this variable block.

The sprite will ask you to type the animal 
you like. Type the name and press Enter 
key. The name of the animal appears in 
the speech bubble of Abby. The name of 
the animal also appears in the variable 
name on the stage.

UNDERSTANDING CONDITIONAL PROGRAMMING
A condition is something that is either true or false. A conditional statement checks whether 
a condition is true or false. There are many tasks that depend on some conditions to be 
true to do the task. 

For example, on a cloudy day, you want to play in the park. There are two conditions:

1.	 If it rains, you will not play in the park.
2.	 If it does not rain, you will play in the park.

Condition blocks work on the condition’s value. There are two conditional statement blocks 
in Scratch.

1.	 If…then block
	� The blocks inside this block will run if the condition is true. If the 

condition is false, the blocks inside this conditional block will not 
run. The blocks outside the conditional block will run. 
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2.	 If…then…else block
	� The blocks inside the ‘then’ condition will run if the condition is true. 

If the condition is false, the blocks inside the ‘else’ condition will run.

Forever and repeat blocks can be used with these blocks.

Now, let us make a small script using the conditional block.

Change the sprite to starfish and the backdrop to 
underwater 1.

Follow these steps to crate the script:

1.	 Drag when green flag clicked from the Event category to 
the script area.

2.	 Drag the Forever block from the Control category and 
put it to the green flag category.

3.	 Drag the move block and put it inside the forever block.
4.	 Then, drag if on edge, bounce block and put it inside the 

forever block.
5.	 Drag if…. then block inside the forever block and snap the 

sensing block, touching colour in the hexagon of the if 
loop.

To get the correct colour, use the dropper and select the colour you want from the 
backdrop.

Dropper Selecting colour from the backdrop
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122 Chapter 8 I Conditional Programming in Scratch

The starfish changes colour and size when it touches the colour selected in the touch block.

CREATING A PROJECT
We have already learnt about different blocks in Scratch. Now, let us create a project 
where the butterfly flies in the blue sky.

Create the given script for the butterfly to move its wings.

Now, click on the green flag and see the butterfly moving its wings. 

After downloading and installing the Scratch app, Scratch projects can be created 
without an Internet connection.

NEWS FEED
CM
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123Chapter 8 I Conditional Programming in Scratch

•	 Blocks in Scratch are made up of different shapes.
•	 Blocks can be grouped into six types—Hat, Stack, Boolean, Reporter, C and Cap.
•	 A Hat block looks like a hat and is designed to start a script.
•	 A Boolean block has pointy ends and looks like an elongated hexagon.
•	 Stack blocks are designed to fit above and below other blocks. 
•	 Reporter blocks report a value.
•	 A C block has the shape of the letter C.
•	 A CAP block ends the scripts. 
•	 Sensing blocks in Scratch are used to detect different factors of a project
•	 Variables are used to hold values.
•	 Variables are of two types—numeric variable and string variable.
•	 Condition blocks work on the condition’s value. 

REFRESH

ACTIVITY TIME

Match the following.

1. 	 	 a. 	 Reporter block

2. 	 	 b. 	 CAP block

3. 	 	 c. 	 Sensing block

4. 	 	 d. 	 Boolean block

5. 	 	 e. 	 Hat block

CT
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124 Chapter 8 I Conditional Programming in Scratch

BROWSE

A 	 Choose the correct option.

	 1. 	� There are grouped into  types.

		  a.   five	 	 b.   six	 	 c.   seven�

	 2. 	� A  block that has a cut of bowl shape at the 

top and a bump at the bottom.

		  a.   Sensing 	 	 b.   Boolean 	 	 c.   Stack �

	 3. 	� A  block that checks if the sprite is touching a 

specific colour and executes the command.

		  a.   condition	 	 b.   variable	 	 c.   sensing�

	 4. 	 The colour of sensing blocks is  .

		  a.   light blue	 	 b.   dark blue	 	 c.   navy blue�

	 5. 	 There are  sensing blocks in Scratch 3.0.

		  a.   18	 	 b.   17	 	 c.   19�

B 	 Fill in the blanks with the words given below.

	 Condition      two      Control        variables       factors

	 1. 	 C blocks are present in the  category. 

	 2. 	� Sensing blocks in Scratch are used to detect different  
of a project.

	 3. 	 There are  types of variables in Scratch. 

	 4. 	� The value of  can be modified according to the script. 

	 5. 	�   blocks work depending on the condition value.
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C 	 Write T for true statements and F for false statements.

	 1. 	 A block can be added on top of the Hat block.�

	 2. 	 Boolean blocks are hexagonal in shape. �

	 3. 	 The Ask block prompts the user to type the input using the keyboard.�

	 4. 	 The value of the variable in Scratch is fixed.�

	 5. 	� In the ‘If…then block’, the blocks inside the block will run if the  
condition is true.�

D 	 Answer the following questions in one word or one sentence.

	 1. 	 Which block always comes on the top of the script?

		

	 2. 	 Which block reports a value?

		

	 3. 	 What is the other name of C blocks?

		

	 4. 	 Which block has a notch at the top and a flat button?

		

	 5. 	 Which block works on the condition value?

		

E 	 Answer the following questions.

	 1. 	 What are the types of blocks in Scratch? Name them.

	 2. 	 What is the difference between a Hat block and a CAP block?

	 3. 	 What is the function of a Sensing block? Explain with an example.

	 4. 	 Differentiate between a numeric variable and a string variable.

	 5. 	 Explain the two types of conditional blocks.
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126 Chapter 8 I Conditional Programming in Scratch

ACTIVITY TIME

Write the function of these blocks.

1. 	 	

2. 	 	

3. 	 	

4. 	 	

5. 	 	

In the computer lab, create this project on Scratch.

You can choose any backdrop and character for the project. 

LET'S EXPLORE

•	 Explain how different blocks function in Scratch.
•	 Demonstrate how to write a script using different blocks.
•	 Encourage the students to create projects using various blocks.

FOR THE TEACHER

CT

EL TE
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LEARNING OBJECTIVES

In this chapter, students will learn about:

Smart homes

Advantages of smart homes

Smart home devices

 SIGN IN

Name four devices that can be operated by voice commands.

1. 	 	 2. 	

3. 	 	 4. 	

Development in technology has made it possible to perform many tasks easily and 
comfortably. New devices have been developed that are well-connected and can 
be remotely controlled. When these devices are used in homes, it provides a better living 
experience for the people living in them. It makes a home a smart home. 

SMART HOMES
A smart home is a house that has a system that 
uses AI to connect the various appliances to perform 
certain tasks automatically. This system also allows 
the homeowner to control some tasks such as 
lighting, security, entertainment, etc., remotely through 
smartphones or computers. It helps to make our life 
simple and convenient. 

Smart Living9

Smart Homes

Scan QR Code to
watch a video

CM
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ADVANTAGES OF SMART HOMES
A smart home has many benefits and makes our life more comfortable. Some of the 
benefits a smart home offer are:

•	 Conservation of energy
Smart Homes are efficient in energy savings. Most smart devices can monitor daily 
energy consumption and can suggest ways to minimise the wastage of energy. Some 
devices also have sensors to detect occupancy and turn off the devices if no one is 
there in the room. 

•	 Security and safety
Smart devices such as smart cameras, smart door 
locks and bells can ensure maximum security to a 
homeowner. These devices also enable the owner to 
monitor the house in real-time when he/she is away. 
Some of the devices such as smoke detectors can 
alarm when it detects smoke and help the people in 
the house feel safer. 

•	 Easy access
A homeowner can remotely access the home 
appliances from a smartphone or a laptop. For example, before leaving the house if a 
person forgets to turn off the heater, he can easily do it through any of the connected 
devices. 

•	 Comfort and convenience
In a smart home, there are various functions which can be operated through your 
phone. It allows flexibility and can it more comfortable for the person living in the house. 
For example, the owner can set a timer to turn on the light before reaching. 

The term ‘smart house’ was coined by the American Association of Home Builders 
in 1984. The term ‘Internet of Things’ or ‘IoT’ refers to the billions of physical objects 
or things connected to the Internet such as sensors, gadgets, appliances and other 
machines. 

NEWS FEED

A man monitoring through a home  
security camera

SMART HOMES DEVICES
An important feature of a smart home is that the devices used in smart homes are 
connected with each other and can be accessed through a smartphone, tablet, laptop or 
remote control. These devices are connected to the internet and use various domains of AI 
like Machine Learning, Natural Language Processing and Computer Vision.

CM
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Here are some of the devices used in smart homes: 

Smart TV
A smart TV is an AI-enabled TV that can be connected to 
the Internet and functions more like a computer. It enables 
access to a wide range of apps and allows the user to stream 
music and videos, browse the Internet and view videos. It can 
be operated through a remote or by using voice commands. 

Smart Doorbells
A Smart Doorbell has a built-in camera and a microphone 
to talk to the visitor. These features provide security to the 
owner who can see the visitor at the door before opening it.

Smart Cameras
Smart cameras are great devices for home security. It helps 
to monitor indoor and outdoor activities. It records everything 
and also sends a signal to alert the owner if there is a breach 
or any other kind of suspicious activity.

A woman rings a smart 
doorbell

A smart camera connected  
to a smartphone

Smart home technology began in 1975 with the invention of X10, a device that works 
with a building’s existing AC wiring and controlled small appliances and lighting 
systems.

NEWS FEED

Smart TV

Smart Smoke Detectors
A smoke detector is used to detect smoke and give a 
signal if there is fire in your home. A smart smoke detection 
system has the technology to pair with Wi-Fi and alert your 
phone when the alarm is activated. 

A smoke detector

CM
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Smart Lighting
The lighting of your house can be controlled through a 
smartphone app. This is called smart lights. It helps to save 
and conserve energy. This allows you to schedule when the 
lights are ON or OFF, set light levels and check the home 
lighting status while you are away. 

Smart Speakers
Smart speakers can be controlled using your voice. They 
understand voice commands and can also perform 
activities like creating a playlist, turning on reminders, 
searching for information on the internet, etc. They have 
built-in voice assistants such as Siri, Alexa and Google 
Assistant. 

Adjusting lighting through a 
smartphone

Alexa

ACTIVITY TIME

Identify the images and write one use of each appliance.

1. 	 		

					   

2. 	 		

					   

3. 	 	

					   

CM
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4. 	 	

					   

5. 	 	

					   

•	 A smart home is a house that has a system that uses AI to connect the various 
appliances to perform certain tasks automatically.

•	 A smart home helps to make our life simple and convenient. 
•	 There are many benefits of smart homes such as conservation of energy, provide 

safety and security, comfort and convenience. 
•	 There are many devices used in smart homes such as smart TV, smart doorbells, 

smart camera, smart smoke detectors, smart lighting and more.

REFRESH

BROWSE

A 	 Choose the correct option.

	 1. 	� It is a device that helps to monitor a smart home.

		  a.   Smart TV	 	 b.   Smart Camera	 	 c.   Smart Doorbell�

	 2. 	� It is a device that allows one to see and speak to a visitor before opening  
the door.

		  a.   Smart Doorbell	 	 b.   Smart Lighting	 	 c.   Smart TV�

	 3. 	 It is a device that detects smoke.

		  a.   Smart Speaker	 	 b.   Smart Doorbell	

		  c.   Smart Smoke Detector	
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	 4. 	 It is a device that can be operated by voice and create a playlist.

		  a.   Smart TV	 	 b.   Smart Camera	 	 c.   Smart Speaker�

	 5. 	 It is a device that functions like a computer. 

		  a.   Smart Camera	 	 b.   Smart TV	 	 c.   Smart Speaker�

B 	 Fill in the blanks with the words given below.

	 remotely        benefits        smart camera        lighting         Internet

	 1. 	 In a smart home, devices are connected to the .

	 2. 	 A smart home has many .

	 3. 	� Smart device such as  provides maximum security 
to the homeowner. 

	 4. 	� Smart homes have a system that allows the owner to  
access the devices. 

	 5. 	� Smart  can be used to check the status of home 

lighting even from away from the home. 

C 	 Write T for true statements and F for false statements.

	 1. 	� Smart homes are possible because of the development in technology.�

	 2. 	 A smart home makes the living experience in these houses tedious.�

	 3. 	 A smart home is efficient in saving energy.�

	 4. 	� The homeowner of a smart home can access the devices in the  
house remotely.�

	 5. 	 Smart lighting is used only to adjust the light levels. �
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D 	 Answer the following questions.

	 1. 	 What is a smart home?

	 2. 	 List the advantages of a smart home.

	 3. 	 How does smart TV work?

	   4. 	� Describe two devices that help in providing security and safety in a  
smart home.

In the computer lab, use the Internet to search for more smart devices that are not 
discussed in the chapter.

Create a chart of how these devices help to make a home a smart home. 

LET'S EXPLORE

•	 Explain the concept of smart homes.
•	 Elaborate on how smart devices help to perform some of the tasks more 

conveniently.
•	 Show and demonstrate how some of the smart devices that are used in smart homes 

work. 

FOR THE TEACHER

EL CRTE
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PERIODIC ASSESSMENT 4 

A.	 Write the names of the group to which these blocks belong.

	     

	 1.	 	 2.  	 3. 

	   

	 4.	 	 5.  	 6. 

B.	 Fill in the blanks. 

	 1.	 There are  types of block shapes in Scratch.

	 2.	�   blocks are designed to fit above and below other 
blocks.

	 3.	 Sensing blocks are  in colour.

	 4.	� A smart  has a built-in camera and a microphone to 
talk to the visitor.

	 5.	�   records everything and also sends a signal to alert 
the owner if there is any kind of suspicious activity.

	 6.	 Smart speakers can be controlled using our .

C.	 Write how these devices help in making a home smart home. 
	 1.	 Smart Smoke Detector

		
	 2.	 Smart Doorbell

		

	 3.	 Smart Camera
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TEST PAPER 2TEST PAPER 2

A.	 Choose the correct option.

	 1.	 In Excel, a collection of cells is called .

		  a.  groups of cells	 	 b.  range	 	 c.  rows and columns�

	 2.	  is a type of Internet connection.

		  a.  Hotspots	 	 b.  Gmail	 	 c.  URL�

	 3.	 Domain name and username are separated by a .

		  a.  comma (,)	 	 b.  period (.)	 	 c.  at (@)�

	 4.	  gives the information in a neat and clean format.

		  a.  Pictograms	 	 b.  Maps	 	 c.  Tables�

	 5.	 C blocks are called  blocks.

		  a.  surround	 	 b.  wrap	 	 c.  big�

	 6.	  helps in saving and conserving energy.

		  a.  Smart speakers	 	 b.  Smart camera	 	 c.  Smart Lighting�

B.	 Fill in the blanks.

	 1.	 In the email, BCC stands for .

	 2.	 The full form of email is .

	 3.	 A web browser is an  to access websites. 

	 4.	 In Scratch,  block is used to run the script continuously. 

	 5.	 Smart  are efficient in energy savings. 

	 6.	� A  system has the technology to pair with Wi-Fi 
and sound an alarm when smoke is detected.

C.	 Write T for true statements and F for false statements.

	 1.	� In the range A2D5. A2 is the address of the upper left cell and D5 is  
the address of the lower right cell.�

	 2.	 An email is used to send messages to other people electronically.�
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	 3.	 An email account is required to send and receive emails.�

	 4.	 All the blocks in Scratch are of the same colour.�

	 5.	 Smart homes use devices that are Internet and AI-enabled.�

	 6.	� Siri and Alexa are examples of built-in voice assistants used in smart  
lighting.�

D.	 Define the following.
	 1.	 Web browser

		
	 2.	 Email address

		
	 3.	 Data

		
	 4.	 Hat blocks

		
	 5.	 Smart home

		
	 6.	 Smart TV

		

E.	 Answer the following questions.
	 1.	 Write some of the advantages of email.
	 2.	 Write a short note on URL. 
	 3.	 Explain the different parts of an email.
	 4.	 What is a conditional statement?
	 5.	 Write the names of the six types of blocks in Scratch.
	 6.	 How do smart cameras and smart doorbells give security to a homeowner? 
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137Project

A.	 Create the following presentation on ‘Deforestation’ using PowerPoint. You can 
add more content and images. 

Slide 1

Slide 3

Slide 2

Slide 4
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B.	 Create the following worksheet in Excel. 

C.	 In Scratch, develop a script to create a game of falling objects from the sky.

	 You can change the object to any object of your choice. You also add other 
elements such as a backdrop. 

	 Here is the hint for the script.
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139National Cyber Olympiad

(Sample Paper)

LOGICAL REASONING

1.	 Find the combination of numbers so that letters are arranged accordingly to form 
a meaningful English word.

D   I    E    C   S   V   E
1    2   3   4   5    6   7   

	 a.  1, 2, 3, 4, 5, 6, 7	 b.  7, 6, 5, 4, 3, 2, 1
	 c.  1, 3, 6, 2, 4, 3, 5	 d.  1, 3, 4, 2, 6, 3, 5

2.	 What is the minimum number of straight lines required to make the given figure? 
	 a.  9
	 b.  11
	 c.  7
	 d.  10

3.	 Anil is taller than Vijay but shorter than Abdul. Vijay is Shorter than Jack but taller 
than Vinay.

	 Who among them is the shortest with respect to height?
	 a.  Jack	 b.  VIjay	 c.  Vinay		  d.  Anil

COMPUTERS AND INFORMATION TECHNOLOGY

4.	 Select the odd one out.

	 a.  CD	 b.  Hard disk	 c.  Pen drive	 d.  RAM

5.	 Which of the following device is used to convert images from physical format into 
digital format?

	 a.  Printer	 b.  Scanner	 c.  OMR	 d.  Mouse 

6.	 Which of the following devices emits computer audio as audible audio?

	 a.  Microphone	 b.  Webcam	 c.  Speaker	 d.  Scanner

NATIONAL CYBER OLYMPIADNATIONAL CYBERNATIONAL CYBER  OLYMPIADOLYMPIAD
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7.	 Which of the following represents slide sorter in MS PowerPoint 2016?

	 a. 	  	 b.  	 c.  	 d. 

8.	 The small picture on the desktop representing a program is called 
.

	 a.  Drive	 b.  Image	 c.  Picture	 d.  Icon

ACHIEVERS SECTION

9.	 In MS Paint, which of the following options gets activated by pressing <Ctrl> + <E>?

	 a.  Bitmap	 b.  Thumbnail	 c.  Properties 	 d.  Gridlines

10.	 Ms. Reddy has to make a presentation in MS PowerPoint 2016 for her company and 
she has to include graphics, audio and video clips. Which of the following options 
will help her to insert an image?

	 a. 	  	 b.  	 c.  	 d. 

140 National Cyber Olympiad
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